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eVSM Help materials include tutorials, examples, and reference. This manual contains the
reference help. For tutorials and examples, visit evsm.com/help. The manual organization follows
the organization of the eVSM Toolbar.

The manual is designed both for on-screen viewing and print. For on-screen usage, the manual is
best viewed in Acrobat Reader. To search, use the Ctrl+F shortcut. Also, it is a good idea to set
the Acrobat view to "Show two pages side-by-side".

For hardcopy, print the manual on double sided paper and use the table of contents or the index
to quickly find answers to your questions.

Use CTRL + F to search within this document
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1. The eVSM Environment

eVSM Overview

Value stream mapping provides a high level view of a lean deployment. Its methodology is well
laid out in the series of workbooks from the Lean Enterprise Institute (www.lean.org). The eVSM
software has been designed to complement these workbooks and provide lean practitioners a tool
to support their value stream mapping activities, starting from paper and pencil through
improvement projects, leading to a leaner future state.

The primary modules in eVSM (Sketch, Sequence, Validate, Calculate, Visualize, Improve) are
deliberately organized to match the process steps that we have seen practitioners follow in their
mapping activities.

We have seen eVSM used in three ways in our user community:

1. By practitioners who simply want to capture a map electronically and want access to a
complete VSM icon set that is easy to use.

2. By practitioners that want to draw a map and do simple calculations in Excel corresponding
to data on the map.

3. By practitioners who want highly standardized and automated maps to include icons as well
as variables, lean equations, charts, and improvement methodology.

While the third approach best leverages the software in a lean deployment, its drawback in the
past has been the learning curve associated with its usage. eVSM has introduced ready-built
stencils for different application areas to address this issue. In eVSM v8, the following stencils
are available.

= Quick Enterprise- supply chain and logistics maps

» Quick Manufacturing- plant level maps for discrete parts

= Quick Processing- plant level maps for food products and chemical processing
= Quick Transactional Pro- transactional processes

= Quick Healthcare- patient flows in hospitals

=  Quick MCT- supports manufacturing critical path time calculation assorted with Quick
Response Manufacturing

One hour webinars are available to overview each of the stencils. Contact support@evsm.com for
details.
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Recommended Layout for Quick eVSM

“ | B evsMv6.25.0102 x

:
Stepped

%[ W4 b H[VSM E 4 I

Note that the main eVSM stencil (typically named eVSM vX.XX) is on the right of the screen.
We will refer to this as the “Main Stencil”. Its important that this stencil is never closed.

Any Quick eVSM stencils (such as Quick Mfg) are docked on the left of the screen. We will refer
to such stencils as the “Quick Stencil”. Click and drag the Quick Stencil header bar to move it to
this docked position.

eVSM Pre-requisites and Updates
eVSM requires Windows XP/Win7/Win8 (32-bit and 64-bit), Visio 2003-2013 (32-bit and 64-
bit), and Excel 2003-2013 (32-bit and 64-bit). You can check on the latest eVSM version

available at:  yyww.evsm.com/updates

Starting eVSM

!. The best way to start a blank value stream map is to double-click the eVSM icon on your
desktop. If your Visio security setting is set to anything but low, messages will come up

asking for permission to “Enable Macros”. You must answer “Yes” to these messages for
eVSM to operate.

eVSM Help Site

The Help button on the toolbar requires an internet connection and will open up a web browser
pointed to the eVSM help site at www.evsm.com/help. 2)

Help

The help site is tested with Internet Explorer which is the recommended browser if there are any
problems. We offer technical support for the latest release of the eVSM software through our
Maintenance, Enhancement, and Support program.. Please email us at support@evsm.com.
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eVSM Shapes & Stencils

evSM v8 eVSM has a collection of value stream mapping shapes that appear in the main
eVSM stencils to the right of the drawing page.

I
[12]
L]

These shapes, behaviors, and corresponding functions have been designed from
the outset to support the series of lean workbooks from the Lean Enterprise
Institute (www.lean.org) and its worldwide network partners. The primary

workbook impacting the design has been “Learning To See”.

As software usage has become widespread across multiple industries, the icon
language has been extended to keep pace with practitioner requests and lean
publications in each industry.

ARG R RDIREIRES

o &R 2T 4o~ 0]

In addition to the basic icons to the right of the drawing page, eVSM includes Quick stencils for
Manufacturing, Enterprise, Processing, Transactional, and Healthcare.

These quick stencils offer rapid map development complete with automated analysis and
charting.

Page Resizing

To resize the page, hold down the CTRL key and move the cursor to the middle of the edge of
the page. The cursor will turn into a double-headed arrow. Simply grab the edge and pull it to the
required size.

[ prawing13 - Microsoft ¥isio § =] ]
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- 8 3/

/|

A
v
I—

4 4 » M Page-1 |<

Page 1)1

sl_l;

4 Copyright © 2015 The eVSM Group, All Rights Reserved



Re-opening eVSM Stencils
eVSM Stencils must always be kept open when working with maps. If you have “lost” the eVSM
stencils from your drawing file, here are the steps to re-open them.

In Visio 2003/2007:
= Click “File > Shapes > Open Stencil...”
= Navigate to the following folder: “C:\Program Files\eVSM\Setup\Solutions”
= Select the eVSMIcons.vss stencil file in this folder and then click the Open button.

= Save your Visio file so it “remembers” this stencil for next time.

In Visio 2010/2013:
= In the Shapes pane (on left) click "More Shapes > Open Stencil..."

= Follow the same steps as above.

Note that on 64-bit Windows, the file location is: "C:\Program Files(x86)\eVVSM\Setup\Solutions"

Snap To Grid
Shapes are designed to be grid-sized. The drawing page has a grid on it. Snap shapes to grid
locations for easy alignment.

Resizing Shapes
Avoid resizing shapes whenever possible. Shapes are designed to fit together and resizing a shape

will make “fitting” shapes together difficult and create extra work.

Text Editing

Double-click a shape to edit its text.
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Drag & Drop

ABC Drag and drop eVSM icons from the stencil onto the drawing page.
_ |
N— Blue icons represent stacks of shapes. Access the stack by dragging out the shape
L v . )
and then clicking the right mouse button.
s
O C Cross Dock

In_Store Storage
Moment_Of_Truth
Picture Process

Process
Process
Process Cell
Production Control

Rework Process
Shared Process
Warehouse

Icons with a blue square in the top right corner symbolize that shapes in that icon stack are used
for visual purposes only, and not used for calculations.’\

—+* | Straight Arrows

Manipulating Text
Double-click a shape to edit its text. Twice per

week

The Visio Text Block Tool (located behind the Text Tool in the Visio Standard T @ m
toolbar) can be used to move the text relative to the shape location. TW‘Ce Per

week
=] =] =]

The Text Block Tool displays control handles around the text belonging to a shape.
These control handles can be used to position and size the text block.

Twice per week

@;; Text Block Tool

Caution: Be sure to de-select the Text Block Tool when finished.

Manipulating Text on Connectors Text on

Text can be added to any connector by double-clicking and typing. /Connector

The Visio Text Block Tool can be used to move the text position along the arrow. Note: The Text
Box Tool is part of Visio, not eVSM tools, and can be found in the Visio menu.

=] =] =]

g 4 .
Texton Caution: Be sure to de-select the
o Texton & Connector

o / Text Block Tool when finished.
@ @
/ °

6
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Visio Pages
Pages can be created, deleted, etc. via the right mouse menu on the page tabs.

Insert Page...
Delete Page
W\ Cument State ), Future State Rename Page

Reorder Pages...

Rules for Visio drawing page naming:

e Page names must start with an alpha character.

e Page names must be limited to 0-9 and A-Z characters. Characters such as [!@#$%"&*()|+-
?] are not allowed.

e Page names should be kept as short as possible.

Zooming In and Out
= CTRL-SHIFT-Drag Select region (Zoom into the selected region).

= Try the Visio menu “View > Task Panes > Pan & Zoom” for another navigation option with
a mini-window.

= To set up the mouse scroll wheel to zoom, use the Visio menus: “File > Options >
Advanced” and check:

[V Zoom on roll with InteliMouse
[V’ Center selection on zoom

= Visio 2010 has zoom controls at the bottom right of the window.

Copy and Paste into PowerPoint or Excel

Visio shapes can simply be selected, copied and then pasted into other Microsoft office
applications like PowerPoint and Excel. Be sure to paste a picture using the “Paste As...”
command. This will allow re-sizing of the pasted picture without requiring editing and font
adjustments.

Acrobat PDF

Acrobat PDF allows capture of any size drawing in a single file, which can be viewed with the
free Acrobat Reader, and is easily printable. On-screen viewing is good, it is searchable, and
supports password security. Visio 2010 allows direct creation of PDF files.

Convert to Bitmap

Common bitmap formats such as JPEG, GIF, and TIFF can be viewed in most browsers without
any additional software. eVSM maps can be converted to these and other graphic formats from
the “File>Save As...” menu. In the “Save As” dialog, click the “Save as type” pull-down and
select the format.
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Printing

Visio allows drawings of any size. The drawings can then be printed on any size paper supported

and available on the printer.

When the drawing size does not match the paper size, you can either print across several sheets,
or shrink (or expand) the drawing to fit the paper by clicking “File>Page Setup...” and then

checking the “Fit to 1 sheet” radio button.

Page Setup

X]

Pint Setup | Page Size | Drawing Seale | Page Properties | Layout and Routing | Shadows |

Printer paper

|Letter: 8.5in. % 11n. ‘i”

() Landscape
Print zoom
(O Adjust to
©Ft to sheet(s) across
by sheet(s) down

Printer paper: 11 x 5.5in,

O Partrait ]

e

Drawing page: 8.5 x 5.51in,

Prink
[aridines

Prink zoom:

Fit to exactly @

)

L ooy | |

The “File>Print Preview” function can and should be used to assess the print output before

committing the drawing to paper.

Printing Problems

The eVSM Software essentially generates a Visio file. The printing of the file is handled by
standard Visio functionality. Problems printing from Visio could be due to Visio, the print driver,

or the printer.

Here are some suggestions if you have problems printing from Visio:

= Make sure you have the latest Visio Service Patch installed

= Try copy/pasting your VSM to PowerPoint or Excel and then print from there

= Convert your VSM to Acrobat PDF and then print the PDF file
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Do’s and Don’ts

DO use a mouse to be productive with eVSM.
DO Snap shapes to grid locations.

DO zoom in fast with CTRL-SHIFT-Drag.

DO zoom out quickly with CTRL-SHIFT-W

DON'T resize eVSM Shapes whenever possible.

- =4 LKL

DON'T close eVSM Stencils.
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2. Sketch

Overview
This section is focused on the first electronic capture of a map and data input. This area is ONLY
for those using Quick stencils.

i] Open Lists the sketcher stencils available and allows one to be selected. The
corresponding Quick Stencil will also be activated. Note that only one
sketcher stencil can be used per map.

@ Wall Map Import a photo of an existing value stream map, and scale for drawing
the map in eVSM.

XY NUM Opens the Name Unit manager which manages the names, units and
equations used on this map. If used in conjunction with a Quick
Stencil, its important NOT to modify variable and unit names or
equations. Typically a few unit names might be added.

B List variables View a window showing all data for the selected center.

How Do | Use the Sketch Module?

The Sketch Module allows you to quickly capture a wall map in eVSM. It can also be used to
simply capture the flow of the value stream with no data. Built in commands allow you to add the
data later when needed. The main steps in the Sketch Module are:

1. Use the Wall Map button to import your wall map picture(s) into eVSM, and scale the image.
2. Use the Open button to select the application area (manufacturing, services, etc.) for your map.
3. Use the Sketch stencil to capture the flow over the wall map image.

4. Once the initial capture has been done, add data to the map and enter the data.
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la. Import Single Image Wall Map

The Wall Map function provides an efficient way to convert an image of the wall into an
electronic VSM. If your wall map is simple enough to capture in a single clear photo (must be
able to read all text), then import the image into eVSM with the steps below. If the map is
complex and requires multiple images then see section 1b on the next page.

Try this:
1. Click the Wall Map button in the toolbar. @ Wall Map

Wall Map Picture Man... ﬂ

2. Click the Insert Wall Map button to //\s [ etwaves |
browse for your wall map picture on R |

Transparency:l E | - |
[~ Map Visibility oK |

your computer.

Select Graphics File... E
®© = 1 L « Pictures » VSM v & | SearchVSM »
: H 0 v Newfold = -
3. Select the picture and click Open. roene e S
~
Y SkyDrive ﬁ ,i
1% This PC
& Desktop Current5tate JPG

| Documents v

File name: | CurrentState.JPG ~ | | JPEG Files (".jpg) v

)

Scale Picture

To scale and fit the picture on page, draw a rectangle over any one process box.

4. To scale the picture, draw a rectangle
over any one process box. Click the
Done button when finished.

Done
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5. Next a form will appear allowing you to change the Wall Map icture Man.. IEH

transparency of the picture, make it visible/invisible ‘
on the page, or delete the picture. After you click OK, et il ‘
if you need to get back to this form, click the Wall

Map button in the toolbar again. @

Transparency: | 60 = -
v Map visibility OK

Wall Map

6. The image will become the background of the Visio
drawing page, allowing you to drop shapes on top \
without it moving. To delete the image, clickthe =
Wall Map button in the toolbar.
@ Wall Map

1b. Import Multi-lmage Wall Map

For more complex maps requiring multiple images, here are some tips for good results:

a.) Take all photos from approximately similar distance from the wall. This will ensure
similar scale.

b.) Capture sufficient overlap between pictures so nothing is missed.

c.) Ensure lighting is similar for all photos.

d.) Hold camera square to the wall to minimize skewing of the image.

1. Use the Insert>Picture option in Visio to import all of the pictures onto your Visio page.

2. Line up the pictures so that the wall map is aligned
properly.
3. Hold down the SHIFT key and select each picture.
Right-click on the selected images and choose
“COpy”.
4. Delete the images from the Visio page. e -
Source:  C:\Jsers\Dilesh\De ipSite \F _v7.vsd\Dr ge-57\Sheet.6
5. Right-click on the page and select “Paste Special”. Sreme e
Choose the “Picture (Enhanced Metafile)” option and . = peen
C I i C k O K . an:;rs the contents of the diipboard into your document as Visio Foreign
o
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All of the images should now be joined into
one single image now. Crop or resize the
image to fit the desired drawing page size.

Click File>Save As. Name the image and then in the “Save as Type” dropdown, select
“Graphics Interchange Format (*.gif)”. Click Save.

File name: | WallMaps.gif v

Save as type: | Graphics Interchange Format (*.gif) »

Click the Wall Map button in the toolbar, and follow the steps on the previous page of la.

Copyright © 2015 The eVSM Group, All Rights Reserved 13



2. Select Stencil Using the Open Form

Try this:

1. To start drawing on your map, click on the Open button in the toolbar to open up the
Sketcher stencil. From the pop-up menu, select which kind of map you’re drawing, for
example, Quick Manufacturing. There is a separate Sketcher stencil for each of the Quick
Stencils used in eVSM.

ﬂ Open

2. Once you select what type of map you’re drawing, the corresponding Quick Stencil will be
placed in the forefront of the other Quick Stencils. Also, the Sketcher stencil will open with
all of the shapes associated with that type of map.

SKETCH MFG x
Drop Quick Shapes here Customer
shift Wk Wk
XX 5 XX
Control Outside Hr day shift
Sketch Sketch — ——|
Inventory Activity \
Sketch Sketch 1 1]
Queue ATh .
H Sketch .Walt sketch Process
Transport Transmit
Sketch Sketch
Process

T i~

Type

The shapes shown above are those used in the example map.

As with all eVSM drawings, start your map by dragging out the red shapes (Customer Sketch and
Time Sketch) first.
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3. Capture the Flow with the Sketch Stencil

If you’re using a picture of a hand-drawn map as a guide, start dragging out the different
Sketch shapes on top of each process as shown below. Otherwise, just recreate your basic
process using the different Sketch shapes.

An alternative method can be done once a
red shape has been placed on the drawing
page. You can use the right mouse button

@ Customer Sketch
Contral Sketch

menu (shown to the right) and select the Outside Sketch

various Sketcher shapes to drop them at Inventory Sketch

the location clicked on the page. Activity Sketch
Wait Sketch

Note: If you need additional map space,
hold down CTRL and click and drag the edge of the page.

Transport Sketch

£

St T =
Type Typ:

.,
A
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4. Add data to the map
Now you can either add data to an individual shape or to the whole map. If you right-click on
any shape, you will see 4 options regarding the adding and removing of data:

e Add all data (shape): adds input and calculated data to the specific shape that you have
selected

e Add all data (page): adds input and calculated data to all shapes on that particular page

¢ Remove all data (shape): eliminates the input and calculated data from the specific shape
that you have selected

e Remove all data (page): eliminates the input and calculated data from all shapes on that
particular page

For this example, right-click on any shape and select “Add all data (page).

|A001
:
o

3 F a2 "
CIvity Leat : ey 7 = Customer
A d J okl g TV -
T el  geang | = [T

. 3 - ! -y 4
iy
g -
1o - . -
010 B 4 - = g
0 (- / h o
£
4 4 o [n002) @Q &
Transport o £ ’ . ) » 0 4
Frequency| g = £ ¥ N 5 N\ . -
Tanspo A e e
! > - A T Transport i
rt Time - o / Frequency| ** [y
R % Tanspo|

rt Time

B o [ / 2
Process 200 a Process v W a Process
2 2 2

Type : Type Type Type

ln003)
a

Inventory| xx [tem Cycle Time | x. i Inventory| xx |item Cycle Time i Inventory| xx [tem Cycle Time | x. i Inventory| xx |item

Qty Per Cycle Qty Per Cycle Qty Per Cycle
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Annotate the map and fill in the values according to your wall map. Now you can finish the

map by adding arrows from the eVSM main stencil and add-on variables from the Quick
stencil.

Customer

Demand

o w2l
0
Transport| | #

10
Transport [ ¢ [0
q Frequency] W
Tanspo| Tanspo|
rt Time 30 "{ 1t Time 30 ”{
A0L A0L A0L
50 0 0
. .
o1 /T Mold Handles AOIVI - Sharpen AOlVI - Assemble o Was
0 60 80 [1] 00
Blanks Molded Blanks Drilled Blanks Scissors
Inventory | 7500 fte Cycle Time | 3 [Min Inventory‘SSSD ltem| Cycle Time | 4 |Min \nvenlory‘mon item Cycle Time | 6 |Min Inventory | 9000 |item
Qty Per Cycle 5 Item Qty Per Cycle 5 Item Qty PerCycle| 10 |ltem
Day Wk
14 5
Hr Day Auto X Day Auto  Day Auto  Day Auto  Day
Auto  Min Auto  Min

Auto  Min
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Units Handling

If you want to create a custom unit that you would like to use throughout the map, start with the
Name and Unit Manager. If you want to use a built-in unit but need to convert it, such as Weeks
to Days, start with Step 3.

Try this:

1. Click the Name and Unit Manager button in the eVSM toolbar. | Xy nuM

Mame and Unit Manager

Name & Unit Sets Map : Units
Save To Set.. Unit 0n Map
Load From Set. 5 Mo« New Unit..
—_— % Mo
Delete Set., Co Mo Modify Unit. .
_— Day Mo
Import Set.. ft Mo Delete Unit. .
T Hr Yes
Expart Set.. Ttem Yoo Delete Unused
Km Mo
Min Yes ﬂ Select Shapes

Map : Names [NVU's)

Mame 0n Map Hidden Default Unit  Filter:
Activity Daily Demand Mo Mo Item " Mew MName.
Activity NVA MNo MNo Min
Activity NVA Per Them MNo MNo Min
Activity Takt Time Mo Mo Min
Activity Time Per Day Mo Mo Hr
Activity VA Per Item Mo Mo Min
Assoc, Time Per Cydle MNo MNo Min
Assoc, Time Per Ttem Mo Mo Min
Associates Mo Mo Staff
Batch Size Mo Mo Item
Changeover Loss Per [tem Mo Mo Min

Load From Map Set Page Link Scope Unit Converters
MNew Unit

Select or Type In Mew Unit ID.
IUse 5 or less Alpha and
Mumeric Characters Only

2. Click on the “New Unit”

Part] - i
| J button in the form and
Cancel | oK create a new unit named
“Part”.
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3. Drag out a Units Converter shape from the Quick Extras stencil or the main stencil on the
right of the screen.

B Quick Extras X
E:D Finished _, |Straight .
Goods Arrows
Stepped Curvable
= Arrows ¢ Arrows Hr
FIFE\FIFO Arrow | 4_* [Interact 60
-y T rt Min
= ranspo
Fm Shapes Waste Shapes
= | Transmit % Units
Shapes [HIH] | Converter
. Data Source —l— Drata Target
w
Select Unit 4. Double click on the default unit “Hr” to change the top unit
Double-Click to Select Unit to “Part” and the default unit “Min” to change the bottom
o = unit to “Item.” This allows the calculator to account for the
é‘g’m new unit. The top unit is the original unit, while the number
Ejr‘; specifies how many of the bottom unit makes up one of the
Er top unit.
G
Km
kw
Kh Hr Part
LQ
m 60 — 2
Mile
Min Min Item
Mth =
none
Parts
RPN
Sec
SgFt
Sam
Staff i
Note: If your desired unit is missing
from the list make sure there is 2 unit

convener between the desired unit and
& unit in this fist

| Manage Mames and Units. . |

| Cancel | | OK |
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5. If you have more than one custom unit, repeat step two and three.

Part Box
2 60
Item Part

Note: Only the custom units that you created via a unit converter(s) will appear in the form when
trying to change a variable unit on a center. This is to avoid (for example) people converting
quantity units to time units for a center, like the Inventory Center. To ensure that the units you
want to change appear in the form, create the converters first between any units you plan to use.

A0010

I

Type

Inventory| xx

Item

6. Double-click on the unit.

7. This form appears showing
that it is “legal” to
convert “Item” to “Box”
or “Part” because unit
converters exist between

these three.

Select Unit

Double-Click to Select Unit

Item
Part

Note: If your desined wnit is missing
from the list make sure there is 2 unit
conventer between the desired unit and
a unit in this list

‘ Manage Mames and Units, . |

| Cancel | | OK |

/A0020 I P

Type

\

Inventory| xx |Box

8. Selection of “Box” in the
form causes the unit to be
replaced in the data box.
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Miscellaneous Tips

eVSM comes with built-in basic unit conversions that don’t require a Units Converter. To check
and see which unit conversions are included, open the NUM and click “Unit Converters.”

Name and Unit Manager

New Unit..

Modify Unit. .

Delete Unit.

Delete Unused

Select Shapes

MNew Name. .

Modify Name. .

Delete Name. .

Delete Unused

Select Shapes

Sequence..

Hame & Unit Sets Map : Units
Save To Set.. Unit On Map
Load From Set. 3 Mo a
—] e No
Delete Set.. 1to10 No
P co No
Import Set.. Day No
I Euro No
Export Set.. ft Mo
Hr No
Item No LJ
Map : Hames (NVU's)

Name On Map Hidden DefaultUnit  Filter:
Activity Demand No No Item/Day -
Activity Lead Time No No Day
Activity MVA No No Min
Activity NVA Per Unit No Yes Min/Item
Activity Takt Time No Yes Min/Item
Activity Time No No Hr[Day
Activity VA Per Unit No Yes Min/Ttem
Added Cost No Yes §/Item
Added Scrap Cost No Yes 5/Ttem
Annual Inv Carry Cost No Yes K$
Assodiates No No Staff LJ

Load From Map Set Page Link Scoj ‘ Unit Converters ‘ Equation Manager.. I oK |

If the conversion you need isn’t listed, you will need to
include a Units Converter on your map in order to use
your units. If the conversion you need is listed then you
will not need to include a Units Converter. An error
may appear if you add an additional Units Converter for
a conversion that is included in eVSM, such as hours to

minutes.

-

Units Converters

==

Visible  From Value To
- 15gm = 10.76  sSgFrt |
1Km = 1000 m
im= 3.281 f
1Mile = 5280 f
- 1 Min = 80 sec
- 1Hr = 80 Min
- 1kwh= | 1000 wh
- 1kwW = 1000w —
1K$ = 1000 g
- =l
Cancel | oK |
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Managing Names & Units
The Name & Unit Manager (NUM) provides a simple way of managing the names and units on a
map via this toolbar button.

XY NUM

The purpose of this management environment is to:

1. Provide a means to type in a name only once and then use it consistently through out the
map.

2. Provide a means to associate a default unit with a name so that when a name is selected, the
unit is automatically set.

3. Provide a means of creating a starter set of names and units for different application areas
such as manufacturing, healthcare, etc. This will allow a company to create standard
variable sets and deploy them easily.

The NUM function does not allow editing of names and units directly in the data shapes. New
names must first be added to the NUM form. Then they can be accessed via right mouse button
menus on the following data shapes.

Hr

60

‘ Name ‘ XXX ‘ Unit‘ ‘ Name ‘ X.XX | Unit ‘ XXX Min ‘ x.xx  Day
! ! Min
Long NVU Short NVU Value Added Non Value Added Units
Converter

The NUM form is divided into three parts: Sets, Units, and Names. Names and units visible in
this dialog box represent the Current Set. Only the Current Set names and units are available on
the right mouse button menu of datasets.

Current Units
MName and Unit Manager

Name & Unit Sets Map : Units
Save To Set.. Unit on M,
Saved Sets\ —| | = =
Load From Set. o MNew Unit., | — .
\ —_— Yo MNo —_— Add New Units
Delete Set.. co MNo Modify Unit..
—_— Day Yes —_—
Import Set.. ft No Delete Unit..
= | Hr Mo - 1
Export Set.. Item Yes Delete Unused
Km Mo
Min No j Select Shapes
Map : Names (NVU's)
MName On Map Hidden DefaultUmit  Filter:
Activity Daily Demand MNo MNo Item - New Namer-\
Activity NVA No No Min _— Add New
Activity NVA Per Ttem Mo Mo Min Modify Mame..
Activity Takt Time No No Min _— Names
L gtivity Time Per Day Mo Mo Hr Delete Name..
Current Names Activity VA Per Item No No Min |
Assoc, Time Per Cyde No No Min Delete Unused
Assoc, Time Per Item Mo Mo Min
Associates Mo Mo Staff Select Shapes
Batch Size Mo Mo Item —_— H ‘ihili
Changeover Loss Per Item Mo Mo Min = = Unit Converter VISIbIIIty
Load From Map Set Page Link Scope Unit Converters Equation Manager.. | QK |
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Fractional Units

Fractional units make computing demand or production much easier.

]

Customer
Customer X tem
Demand ay
N
Try this:

Double-click on “Item/Day,” which will bring up a Unit Selection option.
The Numerator can be changed to a different name, such as “Screw” rather
than “Item,” and the Denominator can be adjusted to a different demand,

such as items per hour.

For the Customer Center, the default unit is items per day. If demand
is calculated on a different basis though, it is simple to change the

units.

If you need to add a new unit, click on “Manage Names and Units...”
which launches the Name and Unit Manager.

N

Customer

Customer
Demand

Screw

XX Hr

This shows the original Customer Center

converted to screws per hour.

]|
Mumerator Denominator

Screw Hr

Min

Sec

-
Unit Selection

P

|

Manage Names and Units..

Cancel oK

When adding a custom unit as a numerator or denominator, it needs to be linked to its units
family using a Units Converter shape. For example, if you're trying to change a unit into "$/
Screw," instead of "$/Item," create a Units Converter showing how many Screws are equal to one

ltem.

If you need to add a different unit of time, such as year, drag out another “Units Converter”
shape from the eVSM stencil, add a new unit using the Name and Unit Manager, and specify the
conversion rate. Make sure you add a Units Converter shape before trying to use a customer unit
as a numerator or denominator in fractional units. It is easiest to keep track of any time

conversions by placing them next to the Time Center.

In this example, “Week” was added as a new unit

and the conversion to days was made using the

N ]

Units Converter. Next, the Customer Demand was ~ |Veek| Pay | Hr | Min
) Customer
changed to items per week. The new unit “Week” 5 | 8 | 60| 60
. .. . . Customer Iltem
can be used in any place requiring a unit. Day | Hr | Min | Sec Demand | °%° (WeeK
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List Variables

To see a list of all of the data on a selected center, using the “List Variables” button will bring up
a form of all of the hidden and visible data.
5 List Variables

Try this:
1. Select the green part of any center on your map. 0080 P

. . ) ) Process
2. Click the List Variables button in the

toolbar to bring up this form. Q) 1

Cycle Time 10 Sec

View Center Data Qty Per Cycle 2 Item

Ll | Process . Item
Capacity Auto Day

AD0B0 Pre OEE Auto ltem

Activity Resource Cost  Auto 50tem _~ | Capacity Day

Activity Takt Time Auto Sec/lter

Activity VA Per Unit Aufo Sec/Tter OEE Percent [ Auto %

Added Cost .00 g/Teem

Added Scrap Cost Auto gdtem

Assodiates 1563

Capacity Auto ItemyDs

Computed Activity Time Aufo HyDay

Computed Demand Aufo Ftem/Ds

Cumulative Cost Auto giltem

Cyele Time 10 5ec

Cycle Time Per Unit Auto Sec/Tter Auto  Sec

Downstr Capacity Loss  Aufo Item/Da L

DownStr Loss Auifo Seciiter

Duration Auifo M

Effective Capacity Auto ItemyDs

End Time Auifo Min

OFF Availability %

OFF Capacity Loss Auto ItemyDs

OFF Loss Auifo Seciiter

OFF Operating Time Autfo HriDay

OEE Percent %

OFF Quality %

OFF Rem Capacity Loss  Aufo Ttem/Da

OFF Remainder Loss Auto Seciliter—

Pre OFF Capacity Auifo FtemyDa

Qty Per Cydle 2 Item

Rolling Scrap Loss Auto Sec/lter

Rolling Scrap Percent % W

Double-Click Variables to Edit
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View Center Data 3. Using the “List Variables” form, you can quickly edit

Lol | Process any variable by double-clicking on it. For example, the
20050 Added Cost for the process was changed the $2 per item,
Activity Resource Cost  Auto S0tem  *| even though it is a hidden variable.
Activity Takt Time Auto Sec/liter
Activity VA Per Unit Auto Sec/liter
Added Cost 2 siitem

A0090 P

Added Secrap Cost Auifo s/tem
Associates 15taF
Capacity Autfo TtemDa Process
Computed Activity Time Aufo HrDsy
Computed Demand Auto Item/Da 0
Cumulative Cost Auto s/dtem U 1
Cyele Tw . 10 Sec Cycle Time 10 Sec
Cyele Time Per Unit Auifo Sec/tern
Downstr Capacity Lloss  Aufo ItemDa Qty Per Cycle 2 ltem
Downstr Loss Aufo Secdter

i ) . Iltem
Duration Aufa Min Capacity Auto Day
Effective Capacity Auto Ttemy/Da Pre OEE At [tem
End Time Auto Min Capacity U0 | Day
GEEAva”bm % OEE Percent | Auto %
OFF Capacity Loss Auifo ItemyDa
OFF Loss Auifo Sec/ter
OFF Operating Time Auto Hr/Day
OFF Percent %
OFF Quality %
OFF Rem Capacity Loss  Aufo Ttem/Ds
OFF Remainder L oss Auifo Secilter— Auto Sec
Pre OFF Capacity Auto ItemyDa !
Qty Per Cycle 2 Item
Roffing Scrap Loss Aufo Secdter
Rofling 5crap Percent % i

Double-Click Variables to Edit

There is also a useful browsing feature that makes it easier to quickly look at all the variables
involved with each center. With the “List Variables” form still open, select another center and
the data form will change to reflect the data of the new selected center. This allows you to update
and add values without having to select each center separately.
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Selecting & Aligning Timeline

eVSM is designed as a grid system and each shape should fit neatly into the lines. If the shapes
aren’t in the grid, it could lead to later issues and so lining everything up should become a habit.
It is best to line up the bottoms of each green center and then adjust the timeline, as shown
below.

A0110 P
Process
A0120 I P
\O) 1 Type
Cycle Time X.XX Min Inventory [ xx |item
Qty Per Cycle 1 Iltem
Auto Day
1
Auto  Min
1

Try this:
1. To move the timeline and get it aligned, you can simply click on the VA or NVA shapes and
manually move them.

2. Alternatively, if you want to shift the entire timeline up or down you can right-click on any of
the timeline shapes and choose “Select Timeline.” If that option doesn’t appear in the menu,
make sure you have the entire VA or NVA shape selected and try again.

3. With the entire timeline selected, you can then move it to where you’d like it.

4. Similarly, in the right mouse menu there is an “Align Timeline” function that will create the
ladder timeline for you if the VA and NV A shapes are not correctly aligned, as shown below.
Auto | Day Disable Flying Connector

Select Timeline
Align Timeline

Auto  Min
1

Auto  Min |
1

Auto Day
|

Auto Min Auto Min
1 1
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Aliases

Aliases are a feature in eVSM that allow a user to convert the variables into another language.
They can also be used for companies that have a common language that is different than eVSM,
such as referring to “Stations” as “Worktables.” Using Aliases allows a map’s names and

variables to be easily updated to fit your needs.

Try this:

To start, first create an Excel file with two columns. In the first column, make a list of all the
variables you would like to create an alias for. In the second column, list whatever you would
like to variable to be changed to, like using the term “Employees” instead of “Associates,” or
translating the eVSM term to another language.

#

;‘Eﬂ AliasData xlsx = [=] s
| A B c |
1 English German
2 % s
| b |
| 3 % %
4 1to10 *1 bis 10
5 | Activity Lead Time " Durchlaufzeit der Aktivitit
B |Activity NVA * Nicht wertschépfende Aktivitat
| 7 | Activity NVA Per Doc *NVA Pro Doc
| 8 | Activity NVA Per Item " Nicht wertsch Tatig pro Post
| 9 | Activity Takt Time ‘Leiﬁtungs Taktzeit
10  Activity Time Per Day " Aktivitat pro Tag
- .
11 | Activity VA Per Doc Leistung VA pro Doc
12 | Annual Inv Carry Cost * Jahrlich tragende Investitions
13 Assoc. Time Loss " Zeitverlust des MA
| k|
| 14 Assoc. Time Per Cycle MA pro Zyklus
| A8 | Accme Flane Pas Pa= ‘7nil Aass RAA wmea Dialaisasat bl
M 4 » M| German . Spanish Company Language [I| 4 [ b _r_

In this example, the English eVSM terms are converted to German. Make sure that you label each
column since the Alias converter starts on the second row in the Excel file.

Also, label each page in your Excel file to whatever alias you’re using, such as Spanish or the
company language.
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The conversions can be done on the entire list of variables and units or just on a select few. In the
example below, the company only wants to use aliases for a few of the variable names so that

their maps closer resemble terms used in the company.

E AliasDataxdex

=

| A B c D E F
1 eVsm Company Terms

2 | Associates Employees

3 |CycleTime CT

4 |Qty Per Cycle Cycle Quantity

5 |Stations Worktables

[

7

8

a

10

11

12

13

14

WA w Spansh | Company Language .~ 73 :1

Once your alias Excel file is complete, draw your map in eVSM or open an existing map. Open
up the NUM by using the button on the eVSM toolbar or by double-clicking on the NUM data

shape.

Name and Unit Manager - Quick Mfg

Name & Unit Sets Map : Units
Save To Set.. Unit On Map
Load From Set. $ No /2 New Unit...
_ % No _
Delete Set.. 1to10 Mo Modify Unit..
—_— co MNo —_—
Import Set.. Day Yes Delete Unit..
- | ft MNo ﬁ
. Export Set.. Hr No Delete Unuses
(13 2
Click on the “Import Name /Uit Alas Ttem Yo
Ké No Select Shapes
1 I t
button In the N U M . "' onie! | | | t\\:::h :: LI Unit Converters
Map : Names (NVU's)
Name On Map Hidden Default Unit  Filter:
Ach:v?ty Demand No No Item/Day - New Name..
Activity Lead Time fes No Day —
Activity NVA MNo MNo Min Modify Mame..
Activity NVA Per Unit MNo Yes Min/Item —_—
Activity Takt Time fes fes Min/Item Delete Mame..
Activity Time MNo MNo Hr/Day T |
Activity VA Per Unit Yes Yes Min/Ttem Delete Unused
Added Cost Yes Yes $/Item
Added Scrap Cost Yes Yes £/Ttem Select Shapes
Annual Inv Carry Cost Yes Yes K$ 3
Associates Yes Nao Staff ~| = lI
Load From Map Source/Target Pages Equation Manager.. | OK |
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Select a worksheet

Company Language

Cancel | oK |

Locate the file on your computer and open
it. A dialog box will appear asking which
worksheet you would like to use. This
example will start with the German
worksheet.

Once you hit “OK,” the variables and units
in the map will be changed to whatever was
listed as the Alias. The map below shows
the updated terms.

A0010 P A0020 P /A0040 P
Process Process
/A0030 I P
Process
O 1 Type %
Durchlaufzeit . )
der activitat 0 Day Zycluszeit XXX | Sec Bestand [ xx |item Zycluszeit XXX | Sec
Menge Pro Menge Pro
Zyclus 1 ltem Zyclus 1 ltem
. Iltem . Iltem
Capacity Auto Day Capacity Auto Day
Pre OEE Iltem Pre OEE Iltem
Capacity Auto Day Capacity Auto Day
OEE Percent | Auto % OEE Percent | Auto %
Auto Day
1
Auto Sec Auto Sec
1 1

If you would like to switch back to the default eVSM names, open up the NUM and turn the

Import Mode off.

MName [ Unit Alias

Import On

off]
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To use a different set of aliases, copy the map to a new page (except for the NUM) and drag out a
new NUM. Import the same data file as before but use the Company Language worksheet instead.
Now, the map shows terms that are used by the company.

/A0020|

/A0030

/A0050

Process Process
A0040 I P
Process
Q) 1 Type Q) 1
Activity Lead Machine Cycle Machine Cycle
Time 0 Day Time XXX | Sec Inventory| xx |item Time XXX | Sec
Cycle Quantity] 1 Item Cycle Quantity] 1 Item
. Iltem . Iltem
Capacity Auto Day Capacity Auto Day
Pre OEE Iltem Pre OEE Iltem
Capacity Auto Day Capacity Auto Day
OEE Percent | Auto % OEE Percent | Auto %
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Adding a new variable

r b |
Name and Unit Manager - Quick Mfg
Name & Unit Sets Map : Units
Save To Set.. Unit On Map
t, $ No o it..
Load From Se % No New Uni
Delete Set.. ito10 No Modify Unit..
— co No -
Import Set.. Day Yes Dedete Unit..
—renzntenid ) @t No - Atmtor e i
Export Set.. e No Delete Unused
Name / Unit Akas Item Yes
/ K$ No Selact Shapes
: Suij oft kktzh NN: LI Unit Converters
Map : Names (NVU's) :
Name OnMsp  Hidden  Defautunt Filter:

Activity Demand No No ItemDay - Name..

Activity Lead Time Yes No Day ﬂ gt

Activity NVA No No Mn Modify Name.

Activity NVA Per Unit No Yes Min/Item

Activity Takt Teme Yes Yes Min/Item Delete Name.

Activity Time No No HrDay

Activity VA Per Unit Yes Yes Mn/Ttem Delete Unused

Added Cost Yes Yes $/Item

Added Scrap Cost Yes Yes $/Ttem Select Shapes

Annual Inv Carry Cost Yes Yes K$

Assocates Yes No staff _v| __Seauence..

Load From Map Source/Target Pages I Equation Manager.. I oK

If you want to add in a new variable with an Alias, click on the “New Name” button in the NUM.

Fill in the Name and then the Name Alias.

Note that the Name will be used when the
Alias Mode is off and the Name Alias will
be used when the Alias Mode is on.

Now that the name is added to the NUM, it

can be added to the map and it will change

Mew Mame
— Hame
Select or Type Mame Mame Graphic (Optional)
ITarget Cyde Time j Ho Pick Graphic
Graghic
Mame Alias
I Goal Time
— Default Unit
Mumerator Mumber =
kwh - Format
LQ

Mile I

none
-
4

4l |

when the Alias Mode is on or off.

RPN
— Description

v | o ]|
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3. Sequence

Overview
Many of the calculations on the value stream map rely on the process sequence. This is defined
on the map by using process tags, path numbers, and sequence arrows.

@ Tags Set tag defaults that are used for auto-numbering shapes as they are
dropped on the page.

Q) Sequence First select the activity shapes using the shift key and in the
CORRECT sequence and then click this button to create sequence
arrows. This can be done a few shapes at a time. Note that the 'Check’
section in the toolbar does have a hide/show for sequence arrows.
Sequence arrows are critical to upstream/downstream calculations on
the map. No sequence arrow loops are allowed.

#~2| Seq One to Many Select the source activity and using the shift key, select all
downstream activities to connect the source to with tag sequence
arrows. This button is located in the dropdown of the Sequence button.

E Seq Many to One Using the shift key select the source activities from which to originate
tag sequence arrows, to a single downstream activity (the final shape
you select while still holding down the shift key). This button is
located in the dropdown of the Sequence button.

'é...: Auto Pipe Select the activity from which to originate the pipe arrows, then hold
down the shift key and select one or more activities to pipe to.

. , . .
EI Auto Pipe —Many to One Select the activity to be at the head of the pipe arrow(s), then hold
down the shift key and select or more activities to pipe from.

[E] Auto Path Identifies each unique path through the value stream (via tag sequence
arrows) and adds path ID’s to steps.

0| Auto Tag Assigns tags in the order provided by tag sequence arrows.
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Sequence

The Tag Seq Arrow is used with Managed Equations and allows you to perform upstream and
downstream calculations. This example shows how Accumulative Time can be calculated along
the value stream with the use of Tag Seq Arrows.

Managed Equation
A0L0 Aozo/ﬁ

Accumulated Time =
Process A Process B .
@Q ST(CT;Min;0;APPLY)
cT 15 | Min cT 20 | Min + ST(Transport Time;Min;0;APPLY)
AccuTrinnL]nleative 15 | Min Transport [ Ty AccuTrinnL]lleative 45 | Min + UTS(ACCUMULATIVE TIME;MIN;0;APPLY;SUM)

There are two ways to attach tag sequence arrows to tags. The first is to drag out the sequence
arrow from the quick stencil and then glue the two arrow ends to the tags. The second method is
to select a series of tags (or activities) in the correct sequence and then click the Sequence button
in the toolbar.

Try this:
1. Select the shapes in the correct order using the SHIFT key.

!

1ok

Process A Process B Process C

2. Click the Sequence button in the toolbar to automatically create sequence arrows to the shapes.
If these shapes do not already have tags, using the Sequence button after having selected them in
order will automatically attach tags to each shape.

¢> Sequence

A0160 A0170 A0180

Process A Process B Process C
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AutoTag

A quick way to tag activities in order automatically, based on the sequence arrows is to use the

eVSM Auto Tag button. DI:I Auto Tag

The Auto Tag function works by re-tagging the whole map, so it disregards what you want as the
“Next Value” in the Tag and Paths form. It orders the shapes by tag sequence arrows and then z-
order (for un-sequenced rows). Then, it goes through the sequence, and it increments each tag by
the user-assigned interval (in the Tag and Paths form), but otherwise numbers start at 0010 for
each letter prefix.

Tag numbers can also be named manually by double-clicking to edit the text. However, the name
must be unique and must be one letter followed by four numbers.

Each tagged shape will generate a row in the spreadsheet. Any data associated to that shape (via
gluing) will appear in that row. Excel rows are alphabetically sorted by tag number.

The activities will be tagged starting with the tag number and increment value as specified in the

form under the ‘Tags’ button.

The activities will be tagged starting with the tag number and increment value as specified in the
form under the ‘Tags’ button. To add or change an Operation Tag, first select the shapes you
wish to attach a tag shape to. Click on the “Tags” button in the toolbar. o Tags

This will open a dialog box that allow you to choose a tag prefix letter, next value, and increment
value. After deciding those factors, click the “Add Tags” button. Tag ID's

Operation Tags

Alphabetic -
Prefix

@ mmo o m

Mext Value 510

[0

Add Tags
Cancel

Increment

Auto Path

After your shapes have been sequenced, there is an option to automatically generate the path IDs
for all the possible paths on the map based on the sequence arrows. After shapes have been
sequenced using the “Sequence” button in the toolbar, click “Auto Path” in the toolbar. This will
automatically give paths to the shapes in the order that they have been sequenced. |[F] Auto Path

Warning: AutoPath regenerates path numbers for all shapes connected by sequence arrows and
without consideration of the current path number on these shapes.
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Try this:

1. After shapes have been sequenced using the “Sequence” button in the toolbar, click “Auto
Path” in the toolbar. This will automatically give path IDs to the shapes in the order that they
have been sequenced.

|I| Auto Path

A0220 #2 AO1! #2

Process A EQ PRhocess B
#2

/A0880|

A0250 1 A0660 é g 2

2. Next, you can use the Auto Tag button to automatically re-order the operation tags in

sequence, based on the sequence arrows. 5
O Auto Tag

A0010 #2 030 #2

Process A EQ / Process\B

/A0020| /

™~

A0040 /A0050 2
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The Path List

The Path List is used to identify a path or paths that a center belongs to. The shape is glued

above the top right corner of the shape.
A0620| P \/ P

Process

An activity can belong to no paths, one or more, or all paths. The benefit of assigning path
numbers to activities is that the associated activity variables (like NVA time) can be summed up
across the map in a path specific sense.

After you have run the “Auto Path” button, each Path List could look like the following:

13| This is the range of the paths the center is on. This center is on Show Paths on Center
paths 1, 2, and 3 Show Paths on All

Hide Paths on Center

Al

The center is on all paths

Hide Paths on All

Select Shapes with Paths

#3 | The center is on 3 different paths

All Paths

Right clicking on the Path List | P | will pull up a list to display all the path numbers on each
icon. You can also hide or show all paths and perform various functions as shown.

Path Filter List

The Path Filter List, found in the Quick Extras stencil, is used instead of a Path List to get
summary calculations by path or for specifying paths for charts. m

If you would like to specify the paths plotted on a chart

The right-mouse menu option of or summary center, use the right-mouse menu option
“All Paths” will set the Path “Select Paths”, to choose which paths to model.
Filter List to “all”. Path Filter Manager
Al Selected
ot o 5 * \The Lead Time
20032 a . ° Lead Chart will be
Storage Time plotted two paths.
Total Inventory
Storage Area Auto | SqFt ﬂ
Use the “Highlight” button
f to highlight the selected
s paths on the map.
Cancel | oK |
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Auto Pipe

This function allows you to automatically create pipe arrows from one center to many centers.
Alternatively, you can create the pipe arrows from many centers to one center. The main use is
for resource allocation. By adding pipe arrows you can determine which resources are used for
which activities.

Try this:
1. To use this function, select the center from which to originate the pipe arrows then hold down

the SHIFT key and select one or more centers to pipe to. Resource A was selected and then while
holding the SHIFT key, Activity B and C were selected.

2. Click the “Auto Pipe” button to automatically create pipe arrows from one activity to many

activities. e8| Auto Pipe
]

3. Fill in the pipe arrow data of Resource Process Time which shows that Resource A is used for
2 minutes per item for Activity B and 5 minutes per item for Activity C.

AO430‘

Min
2 Item

Activity B

3 Min

Item

Resource PT

Resource PT

A0440

Resource A

Activiti C

button, which is in the dropdown menu of the Auto Pipe 0590

Alternately, you can use the Auto Pipe — Many to One

button, to create pipe arrows from multiple Resources —
into an Activity. :j-—: Auto Pipe — Many to One

Resource PT| 2 |y

Resource A
R pT| 3 |Min
0580 esource Tiem
Activity C
IA0600
Resource A
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4. Validate

Overview
This section contains checking functions to validate the model ahead of analysis.

=}=| Check Must do this before using the Solve button. Performs numerous
checks on the model and reports back any problems.

W

Show Seq. A visibility toggle switch for tag sequence arrows. Generally
recommended that you work with these visible so you can fix
sequence arrows as you modify the map.

Show Pipes Just a visibility toggle switch for pipe arrows. Generally
recommended that you work with these while visible so you can
fix pipe arrows as you modify the map.

W

Z Clear Removes various highlighter shapes used for glue display or
problems displayed by the software.

38 Copyright © 2015 The eVSM Group, All Rights Reserved



Check

The Check function highlights some common problems on the map with a red circle and checks
the model. To run, click this toolbar button:

b
- Check

Problems fixed by the Check function include:

1. Removes hidden data shapes: sometimes when using copy/paste, multiple copies are
created and duplicates are hidden under visible data shapes. Finding and removing these
can be tedious, so ‘Check’ automatically deletes such duplicates.

2. Automatically glues data shapes and arrows based on proximity.

Before After
Mold(—(andles Mold(—(andles
Cycle Time| 55 | Sec CycleT\m? 55 | Sec
C".?I"mgem"e 25 | Hrs C".?Iﬁs"v{ 25 | Hrs

Defects g 22 | ppm) Defects; 22 | ppm

Operators 4 Staff Operalor% 4 Staff

Yield 1 96 % Yield P 96 %

Uptime 85 % Uptime 85 %

3 Works around the Visio glue limitation of 10+ shapes.

Missing Data: Data Shapes which are not properly associated to Rowmaker Shapes (via gluing)
will be missed in the data transfer and are highlighted.

Missing Units Converter: If a variable is used with more then one unit (eg. Cycle time in
minutes and seconds), then a units conversion factor must be provided. Standard time units (e.qg.

sec, min, hr, day) are already included in the time center and don’t require a units converter.

The Tag Sequence Arrow visibility can be set with the switch in the eVSM Toolbar:

P
> Show Seq.

The Tag Pipe Arrow visibility can be set with the switch in the eVSM Toolbar:

f;:, Show Pipes

Use the button below to clear any highlighters off of the map:

Z Clear
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5. Calculate

Overview

This section links the map to an underlying Excel spreadsheet to perform lean calculations with

the results displayed back on the map.

Solve

N

Variational Solve

Writes data out to excel, performs any calculations specified via
managed equations and displays results back on the map. Also updates

gadgets and charts on the map.

Calculates values using variational data.

The eVSM Calculator

The eVSM Solve button in the toolbar provides bi-directional transfer of information between the
map and a spreadsheet. When the button is clicked for the first time in a map, eVSM
automatically creates a new Excel file and puts it in the same folder the Visio file is saved in.
The function only operates on the current map page. All blue “Auto fields” will calculate to the

appropriate values on the map.

Visio

[a]  [an]

Buid

= et Pac

K

Cycle Time| 22 [oecs

[Cycle Time[ 22 Jsec:

Yield (%) | % | %

[Rework s 5 %

Yield (%) | % | %
Rework (%)] 2

A
Solve

A S

Excel

A010 Build
A020 Hand Cart
A030 Pack

Tag  Operation VA
2

B

3
3
7
2

g
secs days| secs

22.00

x x| 22.00

13

= distance

5.

NVA| Data Data

00

Data Data

= yield (%)

5.00 96.00

2.00 96.00

70010 all 70050 all
Time Summary /—\A Time Summary
Lead Time Auto | Day Lead Time | 12.60 | Day
Total Value . Total Value .
Added Auto | Min Added 1288 | Min
Value Added Value Added
Percent Auto % Percent 24.34 %
Takt Time Auto I?(fr?] Takt Time 4.20 | Min

40
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Variational Data

eVSM now supports simple means of specifying variation in data for selected input values and
creates variational output for designated calculated values. The example below pulled from a
Quick Manufacturing example map. Note that this functionality does not with the Quick

Transactional Pro stencil.

Try this:

1. Drag out a Normal Distribution icon from the main stencil and glue to the Cycle Time
variable. Make sure a red glue connection appears to make sure it is glued properly.

A0070 P eVSM v8
Fn & a | Triangular
2. The mean and standard deviation Assemble > [r] Distribution
for the activity’s cycle time was B | Exponential
entered. @ 1.00 I | Distribution
. A S | Mermal
Cycle Time | 10 | Min -5 m 4] Distribution
Qty Per Cycle 1 Item .— | List
= | Distributi
Capacity 84.00 Ilt;am R
Y Output
Variation
600.00 Sec Variation
1 Percentile
3. We want to see what effect this will have on the Lead 20080 P
Time. The Output Variation icon from the main stencil N Time Summary
has been glued to the Lead Time of the Summary Center.  var Solve | Lead Time | 252 |Day
Total Value .
Added 15.00 | Min
.. . Value Added
4. The Variational Solve button is selected and the user Percent 071 | %
PR, . . . S
selects ‘75 solve iterations. Each solve uses a random Takt Time  2520.00| o
TR PR Y o4l Process Time Sec
number generator to “pick” a value from each variational por Unit | 900-00 | oo

input. It also creates a sample output for each designated
out variable. This is a simple type of Monte Carlo

analysis.

5. Right-click on the Output Variation shape and select “Plot

Output Distribution”.

50% < 2.52/

85% < 2.52
-

95% < 2.52

99% < 2.53

/

~
6. The Lead Time has been plotted with the various confidence Normal Distribution
levels.
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Variation Percentile Shape

The Variation Percentile shape, when attached to a variable that is calculated via an equation,
provides a way to access percentile values for any terms in the equation that have an associated
distribution. In the example below, lets say we want to calculate a lead time that will not be
exceeded 95% of the time.

Try this:

1. Connect a Variation Percentile shape from the main stencil to the
target variable (lead time in the example below), and set it to 95.

2. Create a managed equation (refer to page 96 for help) that equates
lead time to the sum of the cycle time.

3. Press the Solve button in the toolbar and note that the lead time
solves to 63.16. Without the percentile specification the answer

would have been 50. Solve

/A0020|

Process

/A0030

/A0040

eVSM v8

Mormal

je

m Jsd| Distribution

List
Distribution

Cutput
Variation
Variation
Percentile

® Block Mng
Equation

Process

Summary

Lead Time 63.16

Min(t

Cycle Time 20

Min

Cycle Time 30

Min
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Source and Target

Data Source and Data Target is used to link the data from different shapes or pages. In this

example, the main map has an Assembly station that is actually a multi-machine. The data from
the Multi-Station Wizard will be linked to the main map for the center.

The main map is below, with the multi-machine beneath it.

: w
Atlas Customer
Sl O B oo | 7000 [
@‘ F @ F Share % 100 %
Effective Auto Item
Sh A bl Demand (Week|
hooao /T \| P apen hoorol /T \| P ssembie lnoos /T \| P
Blanks Q) 1 Moulded Blanks O 1 Scissors
Invenloryl 7500 lHem Cycle Time 1 Min Inver\luryl 3000 lHem Cycle Time 2 Sec Invemoryl 5000 lllem
Qty Per Cycle 5 Item Qty PerCycle| 10 |ltem
Capacity | Auto [ Capacity | Auto '[‘)Z’;‘
Pre OEE A ltem Pre OEE A Item
Capacity o | By Capacity o | By
OEE Percent | Auto % OEE Percent | Auto %
Stations 1 Stn
Auto Day Auto Day Auto Day
Auto  Sec Auto  Sec
A0100 P A0110 P A0120 P Z0050) P
Multiple Station Equiv 123
M1 M2 M3 Cycle Time | 3.45 [ Min
Qty Per Cycle| 1.00 |ltem
Cycle Time_M 4 Min Cycle Time_M 2 Min Cycle Time_M 6 Min Stations 4.00 | Stn
Qty Per Qty Per Qty Per
1 Item 1 Item 1 Item OEE Percent | 85.38 | %
Cycle M Cycle M Cycle M
. . . .. . Hr
Stations_M 2 Stn Stations_M 1 Stn Stations_M 1 Stn Activity Time | 11.50 Day
Activit Hr Activit Hr Activit Hr i
C MY 10 |2 g/ 12 |== g/ 14 |== MS €T Capacily | 800.00 | Item
Time M Day Time M Day Time M Day er Day
OEE OEE OEE MS Capacit
80 | % 90 | % 85 | % Paclly | 68300 | Item
Percent M Percent M Percent M Per Day
Cycle Time Per Item 2.00 Min Cycle Time Per Item 2.00 Min Cycle Time Per Item 6.00 Min MS Cycle Time Per 0.86 Mi
CT Capacity Per Day 300.00 Item CT Capacity Per Day 360.00 Item CT Capacity Per Day 140.00 Item Item ' n
Capacity Per Day 240.00 Item Capacity Per Day 324.00 Item Capacity Per Day 119.00 Item
QPC Contributor 300.00 1tSq QPC Contributor 360.00 1tSq QPC Contributor 140.00 1tSq
All Stations Time 2000 [—F— All Stations Time 12.00 T All Stations Time 14.00 T
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The Assemble activity center on the main map is represented by the equivalent multi-machine.
The goal is to populate the input fields for the Assembly activity from calculated values on the
multi-machine map. The Multi Station Wizard has been purposely designed so that it calculates
the values that the activity on the main map needs AND has the SAME variable names (Cycle
Time, Stations, etc.). In the special case where source and target variable names are identical,
source and target identifiers can be glued to the center shape as shown below.

Linking Variables with the Same Name: Try This

1. In the same file as your main map page, create a new page. Click the Open button and use
the Mfg Multi Station Wizard to create the example map shown on the previous page. After
you have created it, name the page to MS. Drag out the “Data Source” marker from the
Quick Extras stencil (or the main stencil) and glue to the Multi Station Summary Center.
Note that source variables can be located on the same page as the target variable or on
another page in the same file. Enter an ID, like 123 which will be used for the target
marker as well.

B Quick Extras X

e

70010 P

Transport
Shapes

.E R
3]

Multiple Station Equiv 123

Cycle Time | 3.45 [ Min Waste Shapes

Qty Per Cycle| 1.00 | ltem —'E Transmit
Stations 4,00 | Stn Shapes
[ HE ] Its
OEE 8538 | % | Units
(e ] | Conwverter
Activity Time | 11.50 DH_ary .
. Data Source
MS CT C
For Do 1800.00 | Item
MS Capacity
Per Day 683.00 | Item Y Data Target

MS Cycle Time Per,| :
tem 0.86 | Min

Kaizen Cloud

Kaizen
Starburst

GO 8

Key Creator

&0
&0
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2. Go back to the main map page and drag out a “Data Target” marker and glue to the side of
the Activity Center. Enter 123 for the ID. In order for the calculation to be correct, the first
five variables from the multi-station summary center MUST be on the Activity Center. If
they are not, you will have to manually drag them out from the Quick stencil and glue to
the Activity Center.

A0040) P ] Quick Extras =
- Transport -
Assemble el Shapeps

Cycle Time XXX [ Min Transmit

Shapes

Qty Per Cycle 1 Item

Units
M| | Converter

O 1 Waste Shapes
PN
[ HE ]
[ =0 ]

Stations 1 Stn

OEE Percent | x.xx %

Data 5
Activity Time | Xx.xx DHary . ata Source
—I— Data Target
Auto  Min
|
C}«Kaiz&n Cloud
Note that the default setting for the target variable is set £ Etaifgn ,
driours
to sum all of the source variables. You can right-click
on the target and change sum to average, max, or min. = w |Key Creator

3. If the source and target variables are on separate pages, the page where your target variable
is must be linked to the source page. Make sure each page in your Visio File has a
memorable name in order to differentiate pages when setting the scope.
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4. In this example, go to the main map page where your target is and click the NUM button in

the toolbar to open the dialog box to set the page scope.

S| NUM
Mame and Unit Manager - Base eVSM
Name & Unit Sets
Save To Set.,
Load From Set. $ No &l NewuUni.
—_— % No e |
Delete Set.. co No Modify Unit..
Day Ho —_—
Import Set.. ft No Delete Unit..
Hr No |
Export Set.. Item No Delete Unused
: 133 LR} N Unit Al Km No
5. Click “Source/Target Pages” at the el ¥in Yes _Seectshaper
Import none Yes
Sec No ﬂ Unit Converters
bottom of the box and select the page Man : Names (WU's) ————
Name OnMap  Hidden  Defautunt  Filter:
on which your source marker is Ay oo N o j e are._|
Activity NVA Per Item No No Min Modify Name..
Activity Takt Time No No Min |
Iocated . Activity Time Per Day No No Hr Delete Name..
Activity VA Per Item No No Min ]
Assoc. Time Per Cyde No No Min Delete Unused
Assoc. Time Per Item No No Min |
Associates No No Staff Select Shapes
Batch Size No No Ttem 5
Changeover Loss Per Item No No Min j Sl
Select Pages in Scope “ ,—l
Load From Map Source/Target Pages Equation Manager... oK
L 7
Cancel oK

6. On the main map page, click the “Solve” button in the toolbar. See how the target variable
is able to access the source variable values automatically as part of the solve as seen in the

Assemble activity center. You must have a value entered in each of the x.xx fields, even if

it is 0, or the solve function won’t run.

/A0010|
Solve P
Assemble
Notice how the Assemble activity matches the 123
values of the multi-station equivalent machine O 1
summary center. Cycle Time | 3.45 | Min
Qty Per Cycle| 1.00 | ltem
Stations 4.00 | Stn
OEE 85.38 | %
Activity Time | 11.50 D|-e|iry
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Linking Variables with Different Names/Units

In the general case when you are trying to link values of variables with different names, you
should glue the source/target markers onto the side of the variable as opposed to the whole

center.

Target Page

A0050 P
Activity
Q) 1
CT 0.13 Hr 1
Qty Per Cycle 1 Item

If the units are not the same, there must be compatible
unit converters, like Min to Hr, located on the source
page for the solve function to convert the value. If the
units are not compatible and you try to solve, an eVSM
Warning message will appear telling you to create a unit
converter. See the example below which shows different
variable names and units, but was able to link the values
because of the correct unit converter.

Source Page

70010 P

Multiple Station Equiv.

Cycle Time 7.93 | Min 1

Qty Per Cycle| 1.00 | ltem Hr
Stations 4.00 | Stn 60
OEE 56.90 [ % Min
. . Hr
Activity Time | 11.50 Day
MS CT Capaci
b Do |1348.00 | Item
MS Capacity
Per Day 198.00 | Item
MS Cycle Time Per 1.98 Min

Item
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XL Reports

He. x
eVSM has an XL Report builder that will export the tag, operation, type, and custom It
variables one directionally to Excel. Tir

e

i

Try this: Eﬂ

1. After your map has been solved, drag out the XL Report icon the eVSM Icons iz
. e

stencil. =
FH
XL A
Report EE
Tir

e

2. Right-click on the XL Report shape and select “Edit Report Data”.

E“M& Enter a Report Name which will
Tog Prefix =) [~ Report Home be the page name in the Excel

VA W Report
e Mo f
ile.
Mc ke Category Header
D MaQ
VE MR Add..
VFE Ws Modify..
Ve MT ick « ”
g 2 — 4. Click “Add” to create a category
20 S Move Up
Wi Mw L | header.
MK WX Move Down
:; ;1 :; ; Variables In Selected Category
Marme Unit Denom. Unit . c .
e || | o — .. & 5. Click “Add” to select the
Wk = .
Moify.. variables to the export to the XL
Tag Type e
[~ Even No's Delete Report
[ oddMo's Maove Up
I Color Tags |
I white Tags
¥ Arrow Tags

¥ Shp Tags Cancel | oK |

6. Select the desired variable from the dropdown Variable Name
menu. Mame
Cyde Time ﬂ

7. If you don’t want the default unit, uncheck this ~—pp/¥ Set Unit from Name Unit Manager Defauits
box and change the units manually.

[ Add SUM row Cancel | Ok, |
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8. After you have finished adding the desired variables, right-click on the XL Report shape and

select “Run Report”.

Edit Report Data

XL
Report

Tag Operation Type Time
ge}
C
©
€
[
@ 2
S o
= s
q) o
S| B
(®) O
Min Item/Wk
Prepare
A0010 Prepare 5
/7N
A0010_A0020
A0020 Paint 10
7 N
A0020_A0030
Package
A0030 Package 8
A0030_A0040
A0040 Customer 100

Run Report %
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6. Visualize

Overview
The view capability simplifies maps with better utilization of map space. Also allows the
visualization of the numbers using gadgets and charts.

&% Views Opens a window for modifying variable visibility settings for the map.

:2 Gadgets Allows management of gadget families providing geometric views of
key numbers of the map with color coding, scale factors and hide/
show.

E Update Updates all the geometric gadgets based on the current map values.
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Hiding & Showing Variables
To prevent maps from looking crowded, there are a large number of variables in eVSM that are
hidden. The views capability allows you to manage which variables you would like to be hidden/

visible on the map.

% Views

Try this:
1. Click the Views button in the toolbar.

2. This will open the form below which
allows you to manage the visibility of
variables on the map. The dark gray boxes
indicate the hidden variables on the map,
and white boxes represent that the visibility
is on.

3. Check the boxes of some variables that
are currently grayed out.

4. Click OK and the changes will apply to
all centers on the map.

Variable Visibility

Variable Name(s)

Center/Addon Name
Ez;ig;ner
e
=
e

visibility

=] | Inventory

B % Inventory
Center

| MNon Value Added

| Cumulative Cost

| Rolling Scrap Percent

| Material Cost

| Added Cost

| Added Scrap Cost

| Scrap Cost Per Period

| Annual Inv Carry Cost

| Inventory Value

Inventory | %

Default |HideAuhD| Hide All | Show All |

Cancel |

< %

[ (i o i B R I

OK |

There are four options at the bottom of the menu for various quick views.

1. Default: Reverts back to how the centers and variables look when dragged out from the stencil.

2. Hide Auto: Hides all blue calculated variables.

3. Hide All: Hides all variables on the page.

4. Show All: Makes all variables visible.
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Using Gadgets to Visualize Data

Any data on the map can be linked to visual gadgets that change in size and color with change in
the data. Some gadget types are shown below:

(0| B | b | =1 | P2 | B ]| [

Bar Sq. Slider Arc
Height | Area g‘agrz? Percent [ Angle
Gadget | Gadget 9 Gadget | Gadget

Line Tk |Curve Tk
Gadget | Gadget

Each gadget has exactly one size parameter that can be tied to a data value on the map. Here’s
the typical means used to apply and manipulate gadgets:

Try this:
1. Drag out the gadget from the main eVSM stencil and position it near the data value with

which it will be associated (in this case the “Cycle Time”). In this example the Bar Height
Gadget is being used.

Process
i U \—/ Cycle Time 2 Min
Bar Height
Gadget

2. This system shape will be automatically dropped on the page the first time a gadget is used.
If you copy a map to a new page make sure you also copy this shape because it is used to
hold gadget data for the map.

3. Select the gadget, drag and glue the gadget’s yellow flying connector to the side of the
NVU data shape (avoid gluing to the top or bottom of the data shape).

Process

/_\q:i Cycle Time 2 Min
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4. Right-click on the gadget and use the “Activate Gadget” option to create a new gadget
collection. The collection name will be “Bar_Cycle Time”. The name is created from the
gadget type and the data variable name.

A gadget can only belong to one collection. Each collection can only have a single type
(eg. “Bar”) of gadget.

Activate Gadget
Create Gadgets By Example
Show Gadget Collection

Né Manage Gadget Collections

5. You can change gadget scale factors and color code them by modifying the properties of
the associated Gadget Collection. You can easily create additional gadgets tied to other
instances of the same data on the map. Just click on the gadget and use the right mouse
button to select “Create Gadgets By Example” to create the gadget for Process B below.

Process A Process B

Cycle Time 2 Min Cycle Time 6 Min

Activate Gadget

Create Gadgets By Example
Show Gadget Collection
Manage Gadget Collections

6. Note that the new gadget is automatically positioned, scaled and put into the same

“Bar_Cycle Time” collection. If you do not wish to have new gadgets created for the whole

map than select the original gadget, then sub-select an area of the map before using the
“Create Gadgets By Example” menu.

Process A Process B

Cycle Time 2 Min Cycle Time 6 Min
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7. To modify a gadgets scale factor or to color code it, you need to change the properties of its
associated collection. Right mouse click on the gadget and select “Manage Gadget
Collections,” or click the Gadgets button in the toolbar.

Gadget Collection Name

g Show Transfer Highlighted
Collection / Gadgets to Collection

To hide or show gadgets in a
collection, first select the
collection from a list, then
click this button.

Note: the collection list has a
column indicating visibility
status.

19 Gadgets
[

Manage Gadget Collections
Visible Count Type

Parameter
eight

v Visible

You can modify the scale
factor for a collection that
controls gadget size in
relation to data value. Use
the Apply button to see the
new gadget sizes on the map
before exiting the form.

Scale

New...
Rename...

Scale..

Color Code..

Delete

Apply Cancel

DK‘

You can color code
the gadget fill and
font colors based on
the value of the data
to which the gadget
is glued. You can
also simply “inherit”
the color from the
data shape or assign a
color to a gadget
manually.
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Gadget Tips:

Gadgets have a single size parameter that will scale to the data value in which a gadget is
glued via the flying yellow connector.

Gadgets are typically glued to NVU, VA or NVA shapes. When gadgets in a collection are
glued to data shapes with different units, Units Converters are needed on the map to
compute the correct scale factors.

Gadgets have to belong to a collection. They can be put in a collection using the Activate
Gadget command or by transferring them into a collection via the Manage Gadgets form.

Gadget scale factors and color coding can be controlled via the Manage Gadgets form.

An easy way to create a gadget “set” after creating a first gadget is to use the Create
Gadgets By Example in the right mouse button menu.

The Visible switch on the Manage Gadgets form is very useful in showing different
metrics on the map in a presentation environment.

See the “Examples” section on the eVSM help site (www.evsm.com/help) for usage
examples of the different gadget types.

A starter set of gadgets is provided with eVSM. Additional gadgets can be requested by
contacting support@evsm.com.
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Conditional Color Gadget

Fd

The Conditional Color Gadget allows the ability to color code values E
Conditional Color

based on value ranges. Gadget

1. Drag out the Conditional Color Gadget from the eVSM Icons main stencil.

A0020 P 2. Use the yellow flying glue connector to glue to any

variable. Make sure a red glue connections appear,

Process . L
confirming that it is glued.
\O) 1.00
Cycle Time | 15 | Sec 3. Right-click the gadget and click “Activate Gadget” if
QtyPerCycle| 1 |item there is only one on the map, or select “Create Gadgets by

Example” if you would like to add a gadget for that
variable map wide.

OEE Percent | 95.00 | % |« |

Scrap Percent 5 %

15.00 Sec
1

4. Click the Gadgets button in the toolbar. _ﬁ:,) Gadgets

. Manage Gadget Collections
5 . Se I eCt the G ad get COI I eCt I 0 n . Gadget Collection Name Visible Count Type Parameter Scale
CondColor OEE Percent Yes 1 CondColor eight 0.50in. =95 %

Mew. ..

Rename...

Scale..

Color Code..

Delete

Show Transfer Highlighted
= Collection / Gadgets to Collectio

v Visible Apply | Cancel | OK

6. Click the “Color Code...” button.
Color & Text Attributes | NAME : CondColor_OEE Perce...

Color Display Text Value Display

7. Select “Based on Value Ranges(s). € Assign Manually @ Hide Valve
" Same as Attached Shape " Show Value

{+ Based on Value Range(s)
8. Fill in the desired ranges with the fill

Color Value Range(s)
| From: To: Fill Color  Font Color
color. 0 % 75 %o Color.. | Calor..
5 1 color..
0 o, [’} oy, Color.. Calor..
0 a

% Color.. | Color..
Cancel
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9. The Gadget will change to the color chosen. If values

change, so will the gadget color after Solve is run. 0030

Process
\O) 1.00
Cycle Time 15 Sec
Qty Per Cycle 1 Item

Scrap Percent 5 %

15.00 Sec
1
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Plot Name Value

There is now the option to plot the name values for all variables on the map.

Try This:

1. Drag out three activity centers and fill in the values.

2. Right-click on Cycle Time and select “Plot Name Values” in the menu.

A0040 P A0030 P A0050) P
Drill Wash Inspect
Q) 1 Q) 1 Q) 1
Cycle Time 2 Min Cycle Time 4 Min Cycle Time 6 Min
Qty Per Cycle 1 Item Qty Per Cycle 1 Item Qty Per Cycle 1 Item
Auto  Min | | Auto  Min | | Auto  Min
| | |
VSM - Cycle Time
6
5
4
c
= 3
2 —
1 )
[ cycle Time
o Legend
A080 A090 A100
Q> SN (o
F & &L
N \&Q

Enable Flying Connector
Name Help

Select all with Name

Select all with Name on Path
Edit Name.. (Cycle Time)
Edit Unit.. (Min

Plot Name Values

?? Plot Distribution Values

H
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Plotting VSM Charts

XY Charts (Combination & Pareto Charts) - Any numeric data available for analysis in eVSM
can be plotted on a chart such as this:

80 Cycle Time - Takt Time Chart
70 —
60
5 50
$ 40 —
? 30
20 — )
10 - == Takt Time
o = Cycle Time
A010 A020 AO030 A040 AO050
Q
K &é\ N é@% &
Q‘Q’Q s &
@c}b v

Before creating a chart, you must ensure that the data to be plotted is:

- Contained in eVSM data shapes
- The data shapes are glued to the parent rowmaker shapes
- Rowmaker shapes are tagged with Operation Tags

Hint: Use the Glue Check and Excel Check buttons in the eVSM toolbar to verify

Try this:

1. Drag out the XY Chart icon from the stencil, and place it anywhere on the map.

I

XY Chart Chart

Edit Chart Data Right mouse click on the shape and
Prot Chart select the “Edit Chart Data” command.

Create Spreadsheet

2. Set up chart parameters and click “Plot Chart” command in the right mouse button menu.

Enter chart titl Chart Data === Select Y-axis
MHE el e T —=Tag Prefix Chart Title Y-Axis units
v A cle Time - Takt Time Chart Numerator Unit ~ Denoi
Ve o |5ec j
Ve v Variables To Chart

lFb Fao Name Display I~ setMin Y

Set data filters FF s | | TaktTme NEAR —=| I setmaxy
Me VT e . . .
e \ X-Axis Variables will be plotted in

oo oy i sequence shown here.
FK X Use Up Down buttons to
change sequence

<| ‘ ’l Move Down Cyde Time

ML Wy Takt Time

MM [z Chart Description

Chart Description
All | None
Tag Type _

- _/
Optional chart L//p;m‘”/
. .nQ " Ascending Sort
deSCrlptlon J/ :; \C“;:iut::_a:;s {¥ Descending Sort
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Options for Chart Variables:

Add Chart Variable &J‘/( Set a default value for non']
me efault i i
_"fw Iz. /L existent p|0t pOIntS

Activity Lead Time

Activity NVA
Q{ Select Variables to plot J

Activity NVA Per Unit
Activity Takt Time
Activity Time j

Display
" New Bar " Line

€ Stacked On Prior Bar =]

N §{ Select Display Type J

{* Multiple Tags

" single Tag \\
= T~ Enter Tag number for ]
u _peccaer. | \L single tag data plot
Pick Line Pattern, | Pick Fill Pamﬁ‘:N
cacel_| \ Set color of fill or Iines)

3. Click the Plot Chart command in the right mouse button menu. ~~__ -

Edit Chart Data
Plot Chart
Create Spreadsheet

Notes:

= Each eVSM Chart is a group of simple shapes. Avoid ungrouping these as this may displace
some of the shapes.

= Chart will update automatically when the Calculator is run. To update the chart manually,

use the “Update command in” the chart’s right mouse button menu.

Sales & Manufacturing Milestones
Days
90 80 70 60 50 40 30 20 10 0

/Til Sales MilestonesiI
Order Order Shipped Order
Accepted to Customer Approved

—_— Manufacturing Milestones——————————

B T

Manufacturing Inspection Manufacturing
Complete Complete Begins

Milestone Charts

Try this:

1. Get data ready in this format:

Sales Milestones MaNIr};.;f:tcotrL]J;isng
Order Approved| 90 |Days Man;fa_cturing 80 |Days
egins
e e | 0 Joan
Order Accepted| 0 Days M%\:;?;t:treing 15 |Days
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2. Drag out the Milestone Chart icon and click the “Edit” T

command in its right mouse button menu. e wistone @
== art
Milestone
3. Complete the form: ‘ Chart
Milestone Chart @
Chart Title

Sales § Manufacturing Miestones

Taa(s) Axis Labels Milestone Values
C180 " Ascending (* From Zero
C190
' Descending " From Final T
Edit Milestone Chart Data
T

Chart Description Plot Milestone Chart
Create Spreadsheet

Unit
Numerator

Denominator

Day -
E

4. Plot chart.

Sales& Manufacturing Milestones

Days
% @ 70 @ S 4 B 2 100
Milestone| !
Chart 11 !
Graer order Stiped Order
‘Accepted to Customer Approve
Edi Mieslone Chart Data s e i
Plot Milestone Chart — |- Compiete  Compite Beans
Create Spreadsheet ‘ Update Milestone Tag Chart ‘

5. Use the “Update..” command in the chart’s right mouse button menu to update the chart
when the data changes.

Cumulative Bar Charts

The Cumulative Bar Chart allows you to visualize the phases of a value stream on a timeline.

Order Fulfillment Timeline

Days

0 5 10 15 20 25 30 35 40

T T T T T T T T 1

Gl | [ ] | | L]

~ I [ —
Process Order Scheduling Wait for Mfg Manufacturing ~ Wait for Delivery
Order Approval Delivery

B070
1. Get data ready in this format: order Fulfiment
imeline

Process Order 1 Days

Order Approval 8 Days

Scheduling 3 Days

Wait for Mfg 15 |Days

Manufacturing 10 |Days

Wait for
Delivery

1 Days

Delivery 2 |Days

2. Drag out the Cumulative Bar Chart icon

@m/_\
and click the “Edit” command in its right Tir oo ot
) Edit Cumulative Bar Chart Data
mouse button menu. Cumulative Plot Cumulative Bar Chart
Bar Chart Create Spreadsheet
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3. Complete the form:

Cumulative Bar Chart @

Chart Title
|Order Fulfilment Timeline

Tag Axis Labels Name Placement
BO70 - + Ascending (% Center of Bar
Uniit " Descending " Left End of Bar
Numerator " Right End OF Bar
Hr -
Denominator Chart Description
|Day j Chart Description|
Cancel ‘ OK |
4. Plot the chart:
Edit Cumulative Bar Chart Data
Plot Cumulative Bar Chart ——_|
Create Spreadsheet \
Order Fulfillment Timeline ‘
Day
0 s 10 15 0 s 3% % w
S i e

Process  Order  Scheduling Wait for Mfg Manufacturing Wait for ~ Delivery|
Order  Approval very

‘ Update Cumulative Tag Chart ‘

5. The chart will update automatically when the Calculator is run. To update the chart
manually, use the Update command in the chart’s right mouse button menu.
Ladder Charts

The Ladder Chart shape allows you to create timeline and operator balance charts such as the
following:

Operator Balance Chart

i Min
Value Added and Non-value added Time Ladder Min 02 4 6 8 101214 16
0 5 10 15 20 25 30 35
FT T T 1 Operatorl F
A010De-A020Asse A030Insta A040Sold A010De-burr AO20Assembl
burr mble Il switch er Wiring Casting e Lining
Casting Lining
Operator2
B Non Value Added [ Value Added P *
A030Install
switch
Operator3
A040Solder
Wiring
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Try this:

We will plot a Timeline Ladder for the VA/NVA times from this VSM.

A010 A020 A030 A040
bl ke . )
De-burr Casting Assemble Lining Instal switch Solder Wiring
Operator ‘ 3 ‘Mm Operator ‘ 12 ‘Mm Operator2 ‘ 7 ‘Mm Operatord ‘ 13 ‘Mm
1 Min 3 Min 3 Min 4 Min
| 2w | | omn | | amin | [ omin |

1. Drag out the Ladder Chart icon and click the “Edit” command in its right mouse button menu.

EEL /—\ Ladder

— Chart

2. Complete the form:

Edit Ladder Chart Data
Plot Ladder Chart

Multi-Tag Multi-Var Chart Data [z
Tag Prefix Chart Title X-Axis

Create Spreadsheet F A [ n | [Valus Added and Non-value added Tme Lacder Num, Uit Denom,. Unit
V8 Mo Min v| |nore  ~
Wc W | VariablesToChart
Fp Wq | Name [Eriay [~ SetMinX
VME MR Add..
FFr Ws [~ SetMax X
Fe pa Modify
WH WMu Delete X-Axis Scale
M1 Wy & fute € Manual
F1 Fw Move Up
Fr Fx Move Down
ML Wy
WM [z | PathPlotting Options Display Options X-Axis Labels
(¥ Combine Path Filters ¥ Show Key & Ascendng
Al | None " Seperate Path Filters ¥ show Activity Colors {" Descending
Tag Type Chart Description TIndividual Bar Labels
. IV EvenNo's Chart Description (¢ Taas &Description
3. Plot chart: F cines
I Color Tags ¢ Description Only

¥ White Tags  MNone

Ladder
Chart @ Edit Ladder Chart Data o

Plot Ladder Chart ———

Create Spreadsheet \

Value Added and Non-value added Time Ladder i
0 5 10 15 20 25 30 35
A010  A020 A030 A040.
De-burr Assemble Install Solder
Casting ~ Lining switch Wiring
M NonValue Added  [] Value Added

‘ Update Chart

4. The chart will update automatically when the Calculator is run. To update the chart, manually,

use the “Update Chart” command in the chart’s right mouse button menu.
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/. Improve

Overview
Allows addition of improvement ideas on the map supported by Impact matrix, Risk matrix, and
Kaizen Report.

4.7%%| Kaizen Properties Select the kaizen/project property set for the map.

*T‘ Kaizen Export Creates an Excel spreadsheet of Kaizens with their property data.

l"f\ Kaizen Import Reads an Excel spreadsheet of Kaizens with property data back to
eVSM.

7#5 Renumber Kaizens Renumber the Kaizen shapes in the order they are selected.
Numbering starts at 001, and any un-selected Kaizen shapes get
numbered after the selected Kaizen shapes.

EE Map Copy Allows a map to be copied to another page in the file.

Kaizen Standardization

You can now standardize your kaizen custom properties by selecting the set of data for the
Kaizens on the map. The Kaizen Properties button in the toolbar will bring up a form allowing

you to select which properties to standardize on for the map.
J##| Kaizen Properties
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Generating Kaizen Report

1L .
| Kaizen Export

-

The Kaizen Export toolbar button scans the map for all Kaizen shapes (Starbursts) and exports
custom properties associated with the shapes to Excel spreadsheets (Pagename_Kaizen). This

Excel spreadsheet will show the connectivity of Kaizen bursts with activities and other Kaizen
bursts. If you want to edit the custom properties data via Excel, you may do so and import the

data back into eVSM using the Kaizen Import button. |2 | yi76n import

.

3 /\‘ @ Problems can be documented using Kaizen starbursts, which

Kaizen Problem can now be connected to activities as well as other Kaizens.
Starburst
Try this:

1. Open a blank Visio drawing page with the Quick Manufacturing stencil.
2. Drag out an Activity Center.

3. Drag out two Kaizen Starbursts from the Quick Extras stencil. Edit the descriptions to “Reduce

Changeover Times” and “More Frequent Deliveries”.

‘/_\ £y
Reduce Kaizen
M F t
Changeover ore Frequen Starburst

) Deliveries
Times

4. Click the Kaizen Properties button in the toolbar to bring up the form to see which properties

are available as well as a description of each. ,;f} Kaizen Properties

Kaizen Properties

Double-click the word “Visible” tO/->Wsihle Name Description

tOg g I e al I Of th e p ro pe I’tl es 0 n OI’ Off v Problem Description Description of the problem being addressed
I Deliverable What is the deliverable result of the project
- Resources ‘What resources are required to complete the project?
- Sustainment Plan How will the project changes be sustained long-term?
/ v Comments Misc comments about issues, etc
Check or uncheck the boxes to add/ M EstmatedCost T
remOVG pl’OpertIES tO the Standard - Cost Incurred Costincurred up to this peint in project execution
custom properties list when editing T ComotedOneTime  Onedine svings resdtng fom e project
each kaizen on the map. [~ Estmated Annusl Savings  Annusl savings resuling from the project

- : : S : =

Cancel oK ‘
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5. Click the Kaizen Export button in the toolbar to create a Kaizen Report in Excel. || Kaizen Export

ID Kaizen Process Step Data Data Data Data Data Data Data Data Data Data Data Data Data

c oo S

s £ 3

prar [}

© © =

2| 2| g S

3] © = -

€ = © =

Q@ g 2 o] el
o [ as ® 3 3 I ©
o 2 £ - ° ° a= i ]
g|lz|5|=| 8|8 E 3 g &

] Q 5 © © 8 L = © 2

c %0 £ o = [] - ] =
<] ) € € © 3 = = = n 9]
= 2 £ I =1 =1 =3 (S) S x X =
o © o © w0 7] IS 2 ‘= o v ©v ©
© (8] o (] (] (] — (o] o o = fes -

Unit Unit Unit Unit Unit Unit Unit Unit Unit Unit Unit Unit Unit

b | b | b | b | b | | | b | b/ b | b | | | b b |
1 Reduce Changeover Times |Process 1 1 1 1

| h| | b | | | b | h| h| b | | | | h h |
2 Make Frequent Deliveries Process 1 1 1 1

Kaizen Impact Matrix

The Kaizen impact matrix was introduced in a late version of v5 and uses the “Impact” and “Ease
of Implementation” custom properties of kaizen starbursts to plot an impact matrix. The goal of
the matrix is to help select projects for implementation to improve the value stream.

The mini-Kaizens in the matrix copy the custom properties of the originals (map Kaizens). They
are numbered based on the ID’s of the Kaizens on the map (ID’s are circles glued to the top left
of the kaizen shapes). A right-mouse click on any of the mini-Kaizens allows for selection and
highlighting of the parent map kaizen.
)
Try this: tet
1. Change the Impact and Ease of Implementation properties of each starburst by right-clicking
the burst and selecting “Edit Kaizen”. A form will appear allowing you to edit the various
properties. Similarly, you could also edit the values via Excel spreadsheet and use the Kaizen

Import button to bring the values back into eVSM. Eifl i bz
s 001 - Reduce Changeover Times
“ | Kaizen Import Desarpton -
] Problem Description
Impact (1-5): What impact this project will have on Commerts
the value stream.

1= Low, 5= High

Finances
Estimated One Time ’7
Savinas
Estimated Annual Savings ’7

Ease of Implementation (1-5): How easy/difficult by
hy - . . Ty 1,0000 [P
will it be to implement this measurable et mienanaion  [Toor | - |
—_ v s

improvement to the Value Stream? o | -l
1 = Difficult, 5 = Easy
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. Change the fill color of each starburst if you wish.

. Drag out the Kaizen Impact Matrix icon from the Quick Extras stencil and right-click to plot
the matrix, which is shown on the next page.

Kaizen

Impact
Matrix ‘\__/ @

Kaizen Impact
Matrix

AD
Plot Kaizen Impact Matrix ‘

. If map Kaizens are modified, then the Impact matrix can be updated by selecting it with a right
mouse click and the command “Update Chart”.

. Using the Renumber Kaizen button in the toolbar, Kaizens can be renumbered in order starting
at 001. Select the bursts in the sequence you want using the Shift key, and then click the

Renumber Kaizens button. Any un-selected kaizen shapes will get numbered after the selected
kaizen shapes.

1‘5}}1 Renumber Kaizens
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6. Drag out the Kaizen Key Creator from the eVSM Main stencil to differentiate each burst by

description which is shown under the matrix. CHIZEN
KEY

Kaizen Key
Creator

Kaizen Impact Matrix

|

g

Impact On Value

(9]

1 2 3 4
Ease Of Implementation

(001) Reduce Changeover Times

(002) More Frequent Deliveries

aizen!
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Kaizen Risk Matrix

The Kaizen Risk Matrix plots the kaizen starbursts based on the risk likelihood and risk severity
values set up in the “Kaizen Properties” form brought up from the right-mouse menu. It also
multiplies the values together to create an RPN number between 1 to 25.

Edit Kaizen Properties
001 - Projects
Description =4
Problem Description Problem Description

Risk Likelihood (1-5): What is the
likelihood of risk to the Value Stream if this comments Actions or Comments
project is not done/issue is not addressed?
1 =Low, 5 = High

Priarity

Impact 1.0000 + _

Ease of Implementation 1.0000 + | _ | 2
Risk Severity (1-5): What is the Risk Likelihood [ L0000 o

likelihood/impact in the Value Stream if /——b Risk Severity [1oom0 4
this identified risk did actually occur?

Team

1= LOW, 5= ngh Owiner | Project Owner

Cancel

Try This:

1. Drag out a Kaizen starburst shape from the Quick Extras
stencil. Type “Reduce Cycle Time” into the burst. Enter the

Reduce Cycle
Time

values for the likelihood and severity by clicking “Edit
Kaizen” via right-mouse menu.

2. Drag out another Kaizen Starburst. Type “Incorrect
Assembly” into the burst. Enter the likelihood and severity
values via the Edit Kaizen form.

Incorrect
Assembly

3. Drag out the Kaizen Risk Matrix from the Quick Extras @ - K;{zin
stencil. Kaizen Risk Matrix
Matrix
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4. Right-click the chart shape to plot. K;iéin
Matrix

Kaizen Risk Matrix

w

Risk Severity
N

1 2 3
Risk Likelihood

a1

Risk Number (Risk Severity * Risk Likelihood)

25

24

23

22

21

20

19

18

17

16

15

14

13

12

11

10
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Formatting the Kaizen Report in Excel

The Kaizen Report in Excel can be formatted with custom properties of color, font, visibility, and
row height. In order to be able to edit this formats, you need a specific Excel file. To get this file
in the correct location for usage:

Try This:
1. Create a new folder called "eVVSM Standards" at the same level as the “eVSM” folder on the
C: drive>Program Files (x86)

2. Copy the templates file called “eVSMExcelTemplate.xlt” from the C:Drive>Programs Files
(x86)>eVSM>Setup>Resources folder to the newly created “eVSM Standards” folder

3. Customize the templates file as needed by following the instructions below

Once you have clicked the Kaizen Export button in the toolbar and your Excel spreadsheet
appears, there should be a page named “KaizenFormat”. The changes made on this page will

effect the actual report which is page named “PageName_Kaizen”.

|H 1 F MW | WVSM_Kaizen ReadrﬂéFirst V5M | KaizenFormat

lists any editing Calculations editing properties
instructions for page from for the Kaizen
importing values “Solve” Report

Kaizen Report A ReadMe page that Page name of Template page for
(PageName_Kaizen)

In the “KaizenFormat” page in the spreadsheet:
e D1: Change the font color of this cell to set these properties for all Data headers

e D2: Change the font color, boldness, or italics of this cell to set the default for the Property
names

e D3: Change for the fill color or row height of this cell to set these properties for all units
e B5: Change the fill color of this cell to set this color for all kaizen numbers
e Each Property header can have a unique fill color, set by this page

e To hide an entire row or column, right-click the row number or column letter and choose
“Hide”. To unhide that row or column, select the row before and after the hidden one by
holding down the SHIFT key, or the column before and after the hidden one, and then right-

click and select “Unhide”.
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Map Copy
Using the Map Copy button in the toolbar, eVSM can copy your map to another page in the file.

This function saves time as opposed to using Visio’s regular copy and paste functions.

Try This:
1. Click the Map Copy button in the toolbar. EE Map Copy

2. A box will appear asking you to enter a page name for the new page in the file.

Enter copy page name

Enter new page name (imit 25 chars ok
Cancel

| |
3. Type in a new name for the page that is going to be created and click OK.

4. Your entire map will be copied to this new page in the same file.
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8. Extras

Overview

V8 Migrate Provide utilities for upgrading older eVSM maps to v8.
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Migrate Maps to eVSM v8

The following button in the toolbar will migrate eVSM v5, v6, and v7 maps to eVSM v8 format.

V8 Migrate

Once a map is migrated to v8, it cannot be opened in older releases of eVSM.

If you need to open an eVSM v8 file in, say v3 (or any earlier version of eVSM) for viewing/
printing purposes only, here is a workaround:

1. Start eVSM and switch VB Macros Off. Click “Tools > Options > Security”.

2. Switch “Off” this checkbox. ——
¥ Enable Micrasoft Wisual Basic For Applications
3. Exit Visio and open the eVVSM vS8 file. W Enable Micrasaft Visual Basic For Appolications proj

Note: Remember to reverse Step 2 above when you wish to use eVSM v8 again.
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9. Learn

Overview
Provides an on-line access to help resources, example maps, and training options.

? Help Accesses the eVSM on-line help site.
)D Icon Search Search for shapes in eVSM stencils.
|= Stack Help Builds a page full of all the choices available in an eVSM Stack shape

master. Select a blue or green eVSM icon from Quick Extras or any
Quick stencil before running this tool.
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Name Help

/A0020|

1

Y

Process

1

—

For variable name help, right-click any variable and select
“Name Help” in the menu for a description of the variable.

Enable Flying Connector

Cycle Time XXX

Min

)

Mame Help

Qty Per Cycle 1

Item

Auto Min
1

Select all with Name
Select all with Mame on Path
Edit Mame.. (Cycle Time)

Edit Unit.. (Min)

Cycle Time Help

Cycle Time:

Observed time to complete an operation at one station of an activity. Includes the

Activity NVA time associated with that activity.
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Icon Search

The Icon Search button in the eVSM toolbar allows you to search for icons in any of the eVSM
stencils. The search looks at the name and the brief help behind each icon and presents results in

a separate search stencil.

Try This:
1. Click the Icon Search button in the Learn module of the eVSM toolbar. )3 Icon Search

Search eV5M Icons ﬁ

| £VSM Main Stendil j

2. Look for “OEE” in the Quick Mfg stencil.

Search eV5M lcons ﬂ

| Quick Mfg j

| OEE

3 matches

3. The resulting shapes associated with OEE will be brought up in a new search stencil.

¥ Search: OEE x

Activity Activity .
Center Multiddd

@ Activity OEE OEE Activity OEE

o= Availability  |=|Direct

v |Activity OEE | DEE EActivity

—o|Parts EF:E Perfnrmanceé -
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Stack Help

The Stack Help button creates a new page in the file with all of the available shapes for a
selected stack. An icon can be identified as a stack shape if it is blue or green in an eVSM

stencil.

Try This:

1. Select the blue stack Transport Shape from the Quick Extras stencil.

[ Quick Extras X

Stepped -
Finish...
Finished
Goods
_ ., |Straight
Arrows
Stepped
Arrows

Curvable
Arrows

cEIFO+ FIFC Arrow

Interact

Transport
Shapes

"

BE | f EEEL] e

Vaste Shapes
P Transmit
8 Shapes
p
[ HE_] its
e Units
Converter =

2. Click the Stack Help button in the eVSM toolbar. |5 Stack Help

3. A new page will be created with the page name “Transport Shapes_Stacks” in the file with all
of the shapes in the Transport stack.

st
—

-. Customer PickUp

Conveyor

Container Yard

Cantainer Truck

Cansolidator

z

g

9 Ambutance:

Alrpot

Ta s o o [0 o

B Elevator

s a1 s s e s

Shipping Port

Helicopter

Ship

Hand Cart

Hand Carrier

Full Tiuck Load

o
8

Forkift b|  Multistop Truek

Flat Bed Truck

Motorbike

Mik Run

o

Light Truck Load

Deconsolidator

1o 10 [ o s [ s

Inteinational Freight

7
White Glove

&L vmesenar

Walk Palient

Tugger

5

Trick Crane

g

Tovier Crane

Tanker Truck

Stiing VWith Tractor

olnlssElEEEEE

O
(@]
©
<
=
(o]
=
®
N
o
H
(&)
_|
>
(0]
¢
<
(%))
<
[9)
o
c
©

>
Ry
Q
=0
=
w
Py
®
2]
o
e
2
®
a
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10. Quick eVSM

Overview

Quick eVSM consists of ready-built stencils for specific application areas. Using these Quick
Stencils will increase productivity and reduce learning time. Application areas supported include:

» Quick Manufacturing — plant level maps for discrete parts

Cuick Mfg
" uick Manufacturing Network — supply chain, logistics, Ml Customer -
Q g pply g
and distribution for discrete parts and assemblies Center
[eTHTH]
. . . EE% Time Center
» Quick Transactional Pro — transactional processes
Carr:,fCu:ust
= Quick Healthcare — patient flows in healthcare ===] Factors
. ) . - W8 Takt Cent
= Quick Enterprise — supply chain and logistics maps ‘( AL e
J;L Control
» Quick Processing — plant level maps for food products and Center
chemical processing Outside
Q Center
] uick Processing Network — su chain, logistics, an Inventory
Quick P g Network pply ch logist d % y
. . . . Center
distribution for food products and chemical processing
? Inventory
* Quick Warehouse — warehousing process mapping == Demand %
’&* Inventory
- - . . L]
=  Quick MCT - supports manufacturing critical path time —cn| Demand
calculation assorted with Quick Response Manufacturing f—\; Inventory
—o| Min Max
m Inventory
—rn|Storage Area
To access a Quick stencil, click the Open button in the toolbar. i] Open Bl Activity
Center
The Quick Stencils will be located on the left side of the Visio o |Activity
drawing page. Quick stencils contain macro shapes which are = | associa... -

collections of individual shapes, sometimes with names, units and
calculation equations built-in.

Quick eVSM maps must be initiated with the red icons found at the top of each Quick stencil.
Once the red icons from a Quick stencil have been dropped on a page, the page is locked for use
with that Quick stencil. You cannot add content from other Quick stencils. You can however add
icons from the main stencil (right side) at any time. Some icons (eg. Arrows) are available only
in the main stencil.
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Quick Stencils Icon Colors

Red icons are used to initiate the map for the chosen application area. Red icons
must be dropped first on the new map. The red icons block the map from being

used with any other Quick stencil.

Green icons, called “Centers”, are used to represent the flow.

| A . .\ .
= Yellow icons, called “add-ons” are additions to “centers” for optional
]m calculations. These add-ons must be properly glued to the data shapes under the

S Center. The yellow icons that follow a Center in the Quick stencil can only be
@ T, used with that Center. Note the first word in the add-on names matches the parent

1

= Center.
E Magenta icons represent charts.
e || pEe White icons used for miscellaneous macro shapes.

Red Icons in the Quick Stencils

Manufacturing
Data

The red Data icon acts as the vault for all of the system data for the map such as names, units,
equations. Each stencil has its own data icon that must be dragged out first.

A020) all

Customer Customer
Center

Iltem
Day

Customer
Demand

The Customer Center represents the customer is where the customer demand is specified. Where
multiple customers exist, a separate Center can be used to represent each customer.
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Week Year Week
e 52 5
[HIH[=] =)
Time Center Hr Week day

The Time Center shows the actual time (after deducting break times) the value stream operates
for. Activity level local time can be specified for activities which work to a different schedule.

Other units are available.

Quick Stencils Centers (Green Icons)

The Centers typically come out with tags and data shapes properly glued to the parent shape

(green icon)

/A0030

This is an Operation

Tag used to sort

Path List. Used to show specific
P paths. Also used to filter data for

calculations and charts.

XX represents mandatory
data items. Without this
data, the calculations

data for charts. Process
Q) 1
Cycle Time XXX —S<<
Qty Per Cycle 1 Item
The green shape acts as Capacity | Auto 'Itjzr;‘
the pa_lrent. If movc_ed, _ Bre OEE o [tem
everything glued to it will Capacity Day

move with it. OEE Percent | Auto

%

Auto Sec
1

A\

Blue “Auto” fields will be
calculated automatically

be eVSM.

L cannot be completed.

Units can be changed to
other compatible units by
double-clicking.
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Quick Manufacturing
The Quick Manufacturing stencil is designed to represent discrete parts flowing through plant
level manufacturing value streams. Both, the material and information flow may be represented.

The Quick Manufacturing stencil includes built-in calculations for:

= |Lead Time, Value added time, Takt time

= Scrap, OEE, and other common activity losses

= Energy and space calculations

= Multi-stations, part-time, over-time, shared resources
= Cost of activities, inventory, transport, scrap

= Transport distances

= Multi-paths

For tutorials and examples visit; http://www.evsm.com/help

Quick Transactional Pro
Used to draw office, administrative, and general services value stream maps. May be used for
any value streams concerned primarily with information flow.

Supported calculations include:

= Lead Time, Value added time, Takt time, Cumulative Rolling Time
= %Complete & Accurate (%C&A)

= Multi-stations, part-time, over-time, shared resources

= Multi-paths and looping

For tutorials and examples visit: http://www.evsm.com/help

Quick Healthcare
Used to capture value streams that require following a patient through admin and non-clinical
processes.

Supported calculations include:

= Lead Time, Value added time, Takt time, Cumulative Rolling Time
= %Complete & Accurate (%C&A)

= Multi-stations, part-time, over-time, shared resources

= Multi-paths and looping

For tutorials and examples visit: http://www.evsm.com/help
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Quick Enterprise

The Quick Enterprise stencil is designed to provide mapping support for enterprise, supply chain
and logistics maps. The stencil was developed after a review of the workbooks “Seeing The
Whole” and “Lean Fulfillment” from the Lean Enterprise Institute (www.lean.org). The stencil
has been subsequently refined through enterprise mapping projects the eVSM group has been
involved in.

For tutorials and examples visit: http://www.evsm.com/help

Quick Processing

The Quick Processing stencil is designed to provide mapping support for plant level
manufacturing in Process Industries. The stencil was developed after a review of the Peter King’s
book “Lean for the Process Industries”. It is an adaption of standard Value Stream Mapping
methodology to address the non-discrete nature of process manufacturing.. The stencil has been
subsequently refined through processing mapping projects the eVSM group has been involved in.

For tutorials and examples visit: http://www.evsm.com/help

Quick Processing Network

The Quick Processing Network stencil is designed to provide mapping support for supply chain,
logistics, and distribution value stream mapping of chemicals and food processes, that allows
calculation of demand, cost and lead times. It is designed to work with Quick Processing.

For tutorials and examples visit: http://www.evsm.com/help

Quick Manufacturing Network

The Quick Processing Network stencil is designed to provide mapping support for supply chain,
logistics, and distribution value stream mapping of chemicals and food processes, that allows
calculation of demand, cost and lead times. It is designed to work with Quick Processing.

For tutorials and examples visit: http://www.evsm.com/help
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Quick Warehousing

The Quick Processing Network stencil is designed to provide mapping support for supply chain
logistics, and distribution value stream mapping of chemicals and food processes, that allows
calculation of demand, cost and lead times. It is designed to work with Quick Processing.

For tutorials and examples visit: http://www.evsm.com/help

Quick MCT

The Quick Processing Network stencil is designed to support manufacturing critical path time
calculation within the QRM (Quick Response Manufacturing) methodology. Quick MCT has a
small set of drag & drop shapes and a set of units converters that allows data to be input in
production, office or calendar units and then converts values to calendar units for consistent
output. It has been designed to complement the MCT Quick Reference Guide by Rajan Suri. Th
“critical path” provides the MCT number and this is seen visually with its gray and white space
components on the MCT chart.

For tutorials and examples visit: http://www.evsm.com/help

e
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11. eVSM Wizards

Overview

eVSM Wizards are simpler stencils that are meant to be used in conjunction with the Quick
stencils. They do detailed side calculations related to some aspect of the main map, which the
values can then be imported into the main map. The Wizards cover areas such as:

Kanban - to calculate kanban sizing and quantities

Facility Time Pro — allows direct specification by each
weekday of times, shift patterns, and related costs.

Manufacturing Multi Station — calculates the properties of
an equivalent machine that has the same capacity as multiple
machines with differing properties.

Processing Multi Station - calculates the properties of an
equivalent machine that has the same capacity as multiple
machines with differing properties.

EPEI (Every Part Every Interval) — calculates min possible
and actual EPEI intervals for multiple products going
through a single station with differing demands and lot sizes.

POLCA (Paired-cell Overlapping Loops of Cards with
Authorization) — is a variant of Kanban, suitable for
companies which produce many different and/or customized
products.

Standard Work — allows layout of standard work with
manual, machine, and walk times and creates a standard work
chart.

Spaghetti Diagram — allows you to draw paths on a floor
plan and then export a Path Report with distances to Excel.

A3 Report — Creates A3 Reports in Visio with a starter
template and a dedicated stencil of standard shapes from
eVSM.

Event Circle — allows you to visualize all the transactions in
a given pathway or process.

Wiz Standard Work

Lk ata

Wl Customer
Center

Activity
Center

Resource
Center

Resource
Awail Time

Sequence
Center
SWCs
Sumrnary

O SWCS Chart
Balance
Chart

+ Symbols

E 1 [l (o) | [

||

Ad|
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To access a Wizard stencil, click the Open button in the toolbar. ﬂ Open

Wizards contain macro shapes which are collections of individual shapes, sometimes with

names, units and calculation equations built-in. The icon colors represent the same shapes as in
the Quick stencils.

Wizard pages must be initiated with the red icons found at the top of each stencil. Once the red
icons from a Wizard stencil have been dropped on a page, the page is locked for use with that
Wizard. You cannot add content from other Quick or Wizard stencils. You can however add

icons from the main stencil (right side) at any time. Some icons (eg. Arrows) are available only

in the main stencil.
The table below shows which Wizards are designed to work the different Quick stencils.

Quick
Manufacturing
Quick
Manufacturing
Network
Quick Processing
Quick Processing
Network
Quick
Transactional Pro
Quick Healthcare
Quick Enterprise
Quick
Warehousing
Quick MCT

Wiz Kanban

Wiz Facility Time
Pro

Wiz Mfg Multi
Station

Wiz Proc Multi
Station

Wiz EPEI

Wiz POLCA

Wiz Standard
Work

Wiz Spaghetti

Wiz A3

Wiz Event Circle
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Appendix A : Drawing with Base eVSM

Identifying Customers

=)

Operation Shapes

Identifying Operational Steps

Process

/‘@

Operation
Shapes

Start the map at the customer end.

Drag out the ‘Operation Shapes’ icon and right-click the shape
to change it to a customer shape.

Identify operations in the value stream and start at the customer end.

Use the right mouse button to swap to another process shape.

Connecting Operational Steps with Arrows

= -

Process

Process

\, — this Push arrow)

Step ped Information
Arrows Kanban

< Push D
eV

Adding Operational Data

! Drag and drop, then glue arrows to the operations or their data
o shapes for easy future modification of the map.

Use the right mouse button to swap to another arrow type (like

Value stream data which you may later want to use in calculations must be represented in eVSM

data shapes. eVSM has the following data shapes:

oo [mma] Lt |
Long NVU Short NVU Value

A

ALY
1

Non Value
Added

‘ Value = Unit

M ‘ Name ‘x.xx ‘Unit‘ ‘ Value ‘ Unit
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Data shapes consist of two or three fields. To move or delete a data shape, you MUST click on
the Value field. To edit any of the fields, simply double-click on the desired part and you will be

able to make any changes.

Process

e

N:a'r'nyl Name ue |Unit

P
[
'

ValueXUnit Name 7*/alue Unit

Value ~ Unit
Value  Unit

Data shapes must be glued directly, or via other

shapes, to the activity they represent.

Variable Names and Units
To add variable names/units to the right mouse button (RMB) menu, follow these steps:

1. Click the following button in the eVSM Toolbar to open the Name & Unit Manager (NUM)

dialog. éY NUM

2. To add a new unit, click the “New Unit...” button.

3. All variable names must have
a default unit. When adding
new variable names, first
make sure that the unit you
wish to make the default for
the new variable, exists in
the units list. Then, click the
“New Name...” button and
follow the prompts.

Name and Unit Manager

Name & Unit Sets Map : Units
Save To Set., Unit. OnMap o
Load From Set. $ Yes (& New Unit..
EC No L~
Delete Set.. 1to10 Mo ™
co No —
Import Set.. Day fes Delete Unit..
1| Euro No (T
Export Set.. ft e Delete Unused
Hr ‘es
Ttem No ﬂ Select Shapes

Map : Names (NVU's)

Mame On Map Default Unit /\
Activity Demand No Item/Day - New Name.. >
Activity Lead Time Mo Day —
Activity NVA No Min o
Activity NVA Per Unit No Min/Item _—
Activity Takt Time No MinyTtem Delete Name..
Activity Time Mo Hr/Day |
Activity VA Per Linit No Min/Item Delete Unused
Added Cost Mo §/Ttem
Added Scrap Cost Mo Sfltem Select Shapes
Annual Inv Carry Cost No 3 5
Associates No Staff j e

Load From Map

Equation Manager..

=]
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Adding Additional Data Shapes

Additional data can be added to a process. Drag & glue a new NVU to

the bottom of an existing NVU.

[
Process
LNO\?S CT 1 20 fsec
co f 3 [min

Process

CT 20

Data shapes that do not touch the operation or its data shapes directly
should be associated with the operation by dragging the flying yellow
connector and gluing it to the operation.

Cco

Note: Flying connectors should NOT be used where shapes are

/ touching.

Representing VA & NVA data

Pocess | A ™ brocess VA and NVA shapes are available to construct a timeline on
o /Do
the map.
C o D Glue these shapes to operational shapes with a flying
X Uit connector.
Lk | e .
When there are several VA/NV A metrics to be tracked, the
Value Non Value . .
Added Added Long NVU shape should be used instead of the specific VA,

Representing Inventory & Queues

Delay
/\ FIFO Inventory

A\

Inventory
Shapes

NVA shapes.

T Q Hopper
In Tray

‘ ‘ ‘ ‘ ‘ Inventory
Kanban Inventory
Package Forming Inventory
Query
Queue
Silo
Supermarket Inventory
Wait

&

After an inventory shape has been dragged out, it can be changed to a variety of inventory
shapes. Use the right mouse button to swap to another inventory shape (Queue, In-tray etc..).

Representing Inventory Data

[mma]

hort NVU
I

InvenmvyT 20 ‘ m

Tte

Drag out the NVU shape and glue it to the bottom of the inventory rectangle
to document inventory type and quantity. Use additional triangles and NVU
blocks for each inventory type.
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Representing Supermarkets and Buffers

3 _,ri Supermarket and Buffer shapes work in a similar way to the Inventory
Supermarket 205' . Shape. Any data must be glued to the base of the shape.
plts
== 4
Short NVU

Representing Transport Method and Data

=k Process Drag out Transport Shapes and place them on the map or glue them
Transport to arrows. NVU shapes holding related variables can be attached to
Shapes =Y the base of the icons.

= /—% ?® Use the right mouse button to swap to another transport type

- (Train, Helicopter etc..).
Finished Goods

Representing Transmit Method and Data
oot |4 =k Transmit Shapes work in a similar way to Transport
Shapes and are generally applied to information

L ]
_ flow.
=)

Transmit
Shapes

Frameless Transport & Transmit Shapes

yay
Right-click on a transmit or transport shape on the map to show
= @ alternate methods.
Transmit By Foot
Shapes Computer At the bottom of the list is a “Framing” option that allows the
pager  Radio outer box around the shape to be turned on or off. When turned off
o the shape looks as below:
Web Form
Faming )
| —
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Working with Tables

The eVSM Table shape was introduced to allow easy creation of box-score tables on the map.

Starter Table

== This is a simple starter table that can be further customized:
Table a
R e Select Tabl
E'__H___E @ V:e:/CRosv:ndColumnSize
Adjusters
. . . Adjust Table
A right mouse click on any of the table cells brings up a Clne Row Bcow
ione ROW Above
R . . Slone R
table modification menu (right) allowing for row / column \' Ugeeaessf;;vndardwaHeigm
addition and modification. glone Courn on Rignt
Delete Column
Use as Standard Column Width

Resizing Rows and Columns

L o
‘_\ Pick the “Select Table” command in the right mouse menu to highlight the

yellow diamonds. Move these yellow diamonds to the required width and

height positions. Then click the “Adjust Table” command in the right

mouse menu.

Editing Text
Double-Click on a table cell to change its text.

Moving the Table

To move the table to a new position on the map, click the “Select Table” command in the right
mouse menu. Then drag the table to the desired location.
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Tables and Spreadsheets

You can transfer table cell data to the spreadsheet with the “eVSM Calculator” button

Solve

To transfer the data, the table has to be tagged first.

Each table creates its own worksheet page in the Excel Workbook. If the page name is “CS” and
the tag is “A010” then the worksheet in Excel will be called “CS_A010”. If formulas are created

within cells in the spreadsheet, the results of those formulas will appear in the table when the

eVSM Solve button is clicked.

Operation
Tag

Headerl

Header2

Header2

Valuel

Value2

Value2
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Swimlanes

The eVSM Swimlane function allows drawing of VSMs and flowcharts in swimlane layout,
horizontally or vertically. The eVSM Swimlane shape is an implementation of the eVSM Table

function.

To calculate totals or plot charts for each lane, see the Path List function.

Note: The swim lane function in native Visio is NOT supported with eVSM. The eVSM
Calculator will not work if the Visio swim lane shape is on your drawing page.

<
= Lane A | Lane B
L m— >
@ E Vertical
Horizontal 3 Swimlane
Swimlane
Try This:
. . . R Select Table
1. Drag out the Horizontal Swimlane from the main stencil. ?@ View Row and Column Size Adjusters
Adjust Tabl
lej)lri ngeBeIow
2. Right mouse click on any of the lanes to bring up the S ot
. g . . - Use as Standard Row Height
modification menu allowing for row/column addition and Clone Column on Right
. . Clone Column on Left
modification. Delete Column
Use as Standard Column Width
o e &

3. Pick the “Select Table” command in the right mouse menu to
highlight the yellow diamonds. Move these yellow diamonds to the
required width and height positions. Then click the “Adjust Table”
command in the right mouse menu.

4. Double-click the “Header” to edit the text.

5. To move the table to a new position on the map, click the “Select Table” command in the right
mouse menu. Then drag the table to the desired location.
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Appendix B : Analysis with Base eVSM

Excel Rowmaker Shapes
Only shapes with a grey corner in the stencil can be tagged. These are called Excel rowmaker
shapes since each of these creates its own row in the spreadsheet.

Row shape examples: o g - o
Fan = 7~

Operation Transport Table  Transmit
Shapes Shapes Shapes

Common Calculator Problems

The eVSM Calculator has some requirements, and if these are violated, the calculator will stop
and display an error message. The problem area will be highlighted on the map with a red circle
for you to correct. We recommend using the Check button before clicking Solve.

Excel and Visio File Naming

b _— s
Solve

Map.vsd Map.xls

When the eVSM Calculator is run for the first time, the Excel file is created automatically and
saved in the same folder as the Visio file. The Excel file is given the same name as the Visio file.

Unit conversion variables in Excel are also scoped by the page name.

Common Calculator Problems
Duplicate or Unglued Tags: Each Operation Tag on the map must have a unique value and must
be glued to a valid Row Shape.

Overlapping Data Shapes: Some Data Shapes are hidden behind others because of overlap, and
is not allowed.

Duplicate Data Shapes: Each Data Shape within a Row Shape collection must have a unique
variable name.

Grouped Shapes: eVSM Shapes should not be grouped. The Calculator will abort if grouped
shapes are found.

98 Copyright © 2015 The eVSM Group, All Rights Reserved



Data in Excel

Data columns sorted

by variable name
1 -

|Tag Sketcher Operation Data Data Data Data Data Data Data Data

One row per
Rowmaker Shape

activity lead time
added cost
associates
customer dermand
cycletime
inventory

aty per cycle
queue

Day $/ltem Staff Item/Day Min Item Item Day

Ad20 customerprocess | " ] All items in a column have same units
A030 Inventory Type X
AO4D Outside | Process |uac o |
A0S0 Inventory  Type b 0 "B
AD60 Activity Process h 1‘ HIOC 3 z
Ao rEnspon Rows sorted by
Operation Tag

number

Calculations in Excel
Equations may be entered in the spreadsheet cells in which Data Shapes are represented.

Steps: Click the Enter
button

The next time the Calculator - XJE

is run, the result of the BE| ¢ [D/7E| F | & |[HI| I
| 1 | Tag opemti.y / NVA Data Data Data Data
=

equation will be displayed in
the appropriate data shape on Type “=" fo||owed]

the map. The calculated value PR £ | : |2 g
. o = E e =
will be color coded red to , Select ER,- g § £ 3
. = = o = m =
show it is controlled by Excel. 3 Cell secs|days|secs| f | % | %
4
5 |a010 Build b 22.00 5.00 86.00]
B |ADZ0 Hand Cart 135.00°
7 |A030 Pack w2200 2.00 98.00]
e

Note: After the “=" sign, instead of an equation (eg. =C3*D12), static values (eg. =216) can also
be entered. This allows entry of measured metrics directly in the spreadsheet.
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eVSM Equation Manager

All eVSM calculations are done via an integrated Excel spreadsheet. The spreadsheet is created

automatically when the “eVSM Calculator” function is

invoked. Results from calculations in the

spreadsheet are automatically displayed on the map. eVSM supports two types of equations to

perform the calculations:

1. Direct Equations — formulas entered directly into
2. Managed Equations — equations managed by eVS

cells in Excel.
M and automatically inserted as formulas

in Excel.
This section shows the Managed Equations capability in eVSM.
Managed Equations are created in Visio and stored in the NUM shape. e

When the eVSM Calculator is run, they generate Direct Equations in Excel.

Visio

=2 = 1| solve

Managed Equations are
created and stored in Visio

Excel

Tag| Operatior VA | NVA Data Data Data Datal

d
jork (%)

g o
S B8 =
@ > o

A010 Build XX 22.0C 5.0C  96.0(
A020 Hand Cart 135.00

A030 Pack

Direct Equations
in Excel

The Equation Manager form is accessed through the Name and Unit Manager.

XY NUM

on { off

Equation Manager.. | H

Equation Manager
Target Mame
Mon Yalue Added oM :
Value Added i
Modify Eqgn..

ON

Delete Eqn..

0K
on Off
List of Managed / 4k—‘
Equations .

Creating Managed Equations
In this example, we will set up a Managed Equation to ¢

On/Off switch
controls whether or | ¥
not equation will be
applied when
Calculator is run

alculate the Non-Value added (NVA)

times associated with inventory and daily demand. The equation is:
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Our goal is to use a single equation for the variable “Non Value Added” that is applied
everywhere on the map where this variable exists. We will assume two key rules of the Equation
Manager:

»= There is only one equation for each target variable name (left-hand side of the equation).

= An equation is either applied to the whole map (when it is ON), or not applied at all (when
it is OFF).

Equation Manager

StepS: | Target Mame on [ Off
1. Click the New Eqgn.. Button.

2. Select the variable name to calculate and its
corresponding units. This represents the left-hand side
(LHS) of the equation.

Equation Editor

Equation Target ( Left Hand Side of Equation )

Select Target Variable Mumerator Unit Denominator Unit

P |N0n Value Added j |Unit j ‘none j

Formula { Right Hand Side of Equation )

‘ 4. Click Insert

|

Variable for the
right-hand side
(RHS) of the

This equation calculates the non value added time assodated with inventory at each 1
activity by dividing the inventary with customer demand.| eq uat on.

3. Enter a name and
description (optional)
for the equation. — »

Insert Variable.. Insert Unit Converter.. | Validate | View |

Equation Description

OK - Exit NUM | Cancel | OK |

5. Select “Inventory” for 6. Specify

. ~ Insert Variable Form - .
Varlable name and SeIeCt mm]nsm If Variable Not Found Auxdliary Data action to take If
'TEEs ’m " APPLY Defauit / Varlable |S not

the un It it ‘Um j Bs::ﬂm- |r\nne j & SKIP the equation g_/

Identify Tag's for Right Hand Side (RHS) Variable

found on map

Tag Logic Sequence Logic Pipe Logic
P+ Same as Target Tag - ST ¢ Downstream Tag(s) - DTS " Downstream Pipe Tag(s) - DPTS
" Unique Variable On Map -V " Upstream Tag(s) -UTS " Upstream Pipe Tag(s) - UPTS
" Al Tag(s) -ATS " Upstream Arrow() - UAS " Upstream Pipe(s) - UPS
" Downstream Arrow(s) -DAS " Downstream Pipe(s) -DPS
€ same Arrow - SA (" Same Pipe - 5P
" Upstream Connect - UC " Upstream Pipe Connect - UPC
" Downstream Comnect -DC {” Downstream Pipe Connect - DPC

Same as Target Tag - ST
The 5T Option selects the RHS Variable from the same tag thatis assodated with the target (LHS) variable.

Typical usage might be to set 'value added time' for a tag equal to the ‘cycle time' for that same tag. The equation would get
appiied to every tag that has both these variables assodated with it.

7. Select the “ST” option. This specifies how data will get selected from the map. The selections
are based on the Operation Tag and are explained further in the following pages.
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8. Click “OK” to return to the previous form.

9. Type “/” for the diVide/sign

Equation Edftor
Equation Target ( Left Hand Side of Equation ) )
Select Target Variable umerator Unit Denominator Unit 10 . I nse rt th en eXt Varlab I e for th e R H S .
jon Value Added ni | |none - - - -
on e & o ) | Here is the resulting equation:
Formula { Right Hand Side quation }
ST(Inventory;Unit;0;SKIP)/ST{Customer Daily Demand;Un|t;0;SkIF) “ST(I nve ntory U n |t O . S KI P)/ST(Customer
/\ Daily Demand;Unit;0;SKIP)”
Insert Variable.. | Modify Variable. . | Insert Unit Converter. . | Validate | View | \
Equation Description To edit variables in the equation, place the
e o ahiing e oy ot costomer demane e cursor on the variable and click the

“Modify Variable..” Button.

OK - Exit NUM | Cancel | OK. |

11. To convert the Managed Equation into Direct Equations, click the Solve button. Solve

Equation Manager Variables Options

= Same as Target Tag (ST) — Used to select the RHS variable from the same operation tag
as the LHS variable.

= Unique Variable On Map (UV) — Can be used when a variable occurs only once on the
map, so there is no need to specify the operation tag ID for it.

= All Tags (ATS) - Selects the RHS variable from every tag on map where it exists, and
makes a list to put in the Excel function. Typical usage: sum all VA times.

= Downstream Tags (DTS) — Selects the RHS variable from the downstream tag as specified
by the Tag Seq arrows connecting the tags. Typical usage might be for cumulative
calculations starting downstream and moving upstream, like effective yield calculations.

= Upstream Tags (UTS) - Selects the RHS variable from the downstream tag as specified by
the Tag Seq arrows connecting the tags. Typical usage: cumulative time or cost
calculations.
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Block Managed Equations

Each target variable (left-hand side of equation) can be driven by only one Managed Equation.
When the Calculator is run, the Managed Equation will be applied to every instance of the target
variable. Sometimes, you may want to block the Managed Equation from being applied to some
instances of the target variable. This can be done with the “Block Managed Equation” shape in
the eVSM Icons stencil.

—  —a :
& + Yield XXX | %
Block MN
Equation o
| x.xxIMlns

Simply glue the “Block Manage Equation” shape to any data shape which you want omitted from
the Managed Equations calculation.

Note: If the “Block Managed Equation” shape is attached to a data shape AFTER it has already
been calculated, then you must manually delete its direct equation in Excel before the next
Calculator run, otherwise the OLD equation will remain in the spreadsheet.

Sequence Arrows & Pipe

The eVSM Equation Manager has additional variable options for usage with variables on
sequence arrows and pipes. These are primarily development tools for eVSM’s quick stencils and
their usage without developer training is NOT recommended.
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Index

A

aliases

align timeline
arrows

auto pipe
autopath

autotag

B

blue icons

browse data

C

calculator
calculator problems
chart variables
check

clear

conditional color gadget
current set

cycle time

D

data source

data target

direct equations
E

edit variables
enable macros
equation manager
evsm stencils

F

flying connectors
fractional units

G

gadget collections
gadget color-coding

gadget hide/show

27
26
90
37
34
34

25

95
98
61,63
38
39
58
22
56

44
44
100

25
3
100, 102
5

92
23

55
56
56

gadget key points
gadget scale factor
grid

H

help

hide/show

I

icon search

K

kaizen export
kaizen impact matrix
kaizen import
kaizen properties
kaizen risk matrix
kaizens

L

ladder chart

lean enterprise institute
list variables

M

main stencil
managed equations
map copy
milestone chart

N

name and unit manager
non value added
nva

(o)

operational data

P

path filter list

path list

pipes

plot name value

57
56

78
53

80

67
68
67
66
71
66

64

24

100

75
63

18,22

92
92

90

36
36
103
60
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printing 8 visual gadgets 54

Q W

quick stencils 3,82 wall map 11
R wizards 88
renumber kaizens 69 www.evsm.com/updates 3
S X

security setting 3 xI report 49
sequence 33 Xy chart 61
shapes 4 Z

show pipes 39 zooming 7
show seq 39

sketch 10

snap 5

solve 40

source and target 44

stack help 81

stencils 4

swimlane 96

T

tag seq arrow 33

tags 34,102

takt time 56

text editing 5

transport shapes 93

U

unit family 94

units converter 19

\"/

v8 migration 77

va 92

value added 92

var solve 40

variation percentile 43

variational data 41

views 52
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